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Copyright and Trademark Notices
Copyright   1999–2001 The Amanda Company. All Rights Reserved. This 
guide and the software described herein are copyrighted with all rights 
reserved. No part of this publication may be reproduced, transmitted, stored 
in a retrieval system, or translated into any language in any form by any 
means without the prior written permission of The Amanda Company.

Amanda is a registered trademark of The Amanda Company. Other brand 
names and product names are trademarks or registered trademarks of their 
respective owners.

Limited Warranty on Software
The Amanda Company warrants the media on which the software is recorded 
to be free from defects in materials and faulty workmanship for a period of 
90 days from the date the software is delivered. If a defect in the media 
should occur during this period, you may return the media to The Amanda 
Company and The Amanda Company will replace the media without charge.

THE AMANDA COMPANY MAKES NO WARRANTIES (OTHER 
THAN THOSE SET FORTH ABOVE) TO ANY PERSON OR ENTITY 
WITH RESPECT TO THE PRODUCT OR ANY DERIVATIVES 
THEREOF OR ANY SERVICES OR LICENSES AND DISCLAIMS ALL 
IMPLIED WARRANTIES, INCLUDING WITHOUT LIMITATION 
WARRANTIES OF MERCHANTABILITY, PERFORMANCE, 
NONINFRINGEMENT, AND FITNESS FOR A PARTICULAR 
PURPOSE. THE AMANDA COMPANY WILL NOT BE LIABLE FOR 
ANY BUG, ERROR, OMISSION, DEFECT, DEFICIENCY, OR 
NONCONFORMITY IN ANY SOFTWARE. THE SOFTWARE IS 
LICENSED “AS IS,” AND THE PURCHASER ASSUMES THE ENTIRE 
RISK AS TO ITS QUALITY AND PERFORMANCE.

IN NO EVENT AND NOTWITHSTANDING ANY DOCUMENT, 
REPRESENTATION, OR OTHERWISE, SHALL THE AMANDA 
COMPANY BE LIABLE TO YOU FOR DIRECT, INDIRECT, SPECIAL, 
INCIDENTAL, CONTINGENT, OR CONSEQUENTIAL DAMAGES, 
INCLUDING DAMAGES FROM LOSS OR CORRUPTION OF DATA, 
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INTERRUPTED USE, LOST PROFITS, COST OF PROCURING 
SUBSTITUTE GOODS, TECHNOLOGY OR SERVICES, EVEN IF The 
AMANDA COMPANY OR AN AUTHORIZED THE AMANDA 
COMPANY DEALER HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES. YOU AGREE THAT THE AMANDA COMPANY’S 
LIABILITY ARISING OUT OF CONTRACT, NEGLIGENCE, STRICT 
LIABILITY, WARRANTY, OR OTHER LEGAL OR EQUITABLE 
THEORY SHALL NOT EXCEED ANY AMOUNTS PAID BY YOU FOR 
THIS PRODUCT. Any written or oral information or advice given by the 
Amanda Company dealers, distributors, agents, or employees will in no way 
increase the scope of this warranty, nor may you rely on such oral or written 
communication. Some states do not allow the exclusion or limitation of 
implied warranties or liability for incidental or consequential damages, so 
the above limitation or exclusion may not apply to you. This warranty gives 
you specific legal rights, and you may also have other rights which vary 
from state to state. This Agreement shall be governed by the laws of the 
State of California without regard to the conflicts of laws or provisions 
thereof.

Fraudulent Usage Advisory
Although the Amanda software is designed to resist fraudulent usage, 
including unauthorized access to a long distance network, no product, 
including the Amanda software, is able to prevent such unauthorized usage. 
The Amanda software is likewise unable to prevent such uses as may 
constitute an invasion of privacy or other tort. THE AMANDA COMPANY 
MAKES NO EXPRESS OR IMPLIED WARRANTY AGAINST 
UNLAWFUL OR UNAUTHORIZED USE OF YOUR AMANDA 
SYSTEM OR ITS CAPABILITIES AND HEREBY DISCLAIMS ALL 
LIABILITY ARISING FROM SUCH USE. YOU AGREE TO 
INDEMNIFY, DEFEND, AND HOLD THE AMANDA COMPANY 
HARMLESS FOR ANY UNAUTHORIZED OR FRAUDULENT USE OF 
YOUR LICENSED AMANDA SOFTWARE.

THE AMANDA COMPANY
13765 ALTON PARKWAY, UNIT F
IRVINE, CA  92618
TELEPHONE (949) 859–6279  FAX (949) 859–4380
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Customer Service and Support
The Amanda Company provides customer service and support Monday 
through Friday from 8:00 A.M. to 8:00 P.M. Eastern Standard Time, except 
holidays.

Customer Support:
(800) 800–9822

For sales, contact The Amanda Company at the East Coast office.

Dealer Sales:
Telephone: (800) 410-2745

Distribution Sales:
Telephone: (800) 410-2745

International Sales:
Telephone: (203) 744-3600

International Support:
Telephone: (203) 744-0860

Web Site:
http://www.taa.com

End User Support
End user support covers the actual usage of Amanda through the telephone, 
such as picking up messages, sending messages, changing greetings, and 
using distribution lists. Registered Amanda sites receive free end user 
support for the life of their systems. Be sure to send in your registration card!
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System Administration Support
System administration support covers the configuration of Amanda; such as 
setting up mailboxes, programming notification, setting automatic schedule 
changes, and creating reports. Registered Amanda sites receive free system 
administration support for up to six months after the installation. Be sure to 
send in your registration card!

Installation Support
Installation support covers the initial connection of Amanda to a telephone 
switching system as well as problems that occur when the system changes or 
Amanda is upgraded. 

The Amanda Company offers installation support to any dealer who buys a 
turnkey system. 

Qualified Amanda marketing partners and solution providers, who are in 
good standing, receive installation support for any system.

Conventions
This manual uses the following terminology and conventions:

Amanda The name by which this manual refers to the 
Amanda Portal system to make reading about the 
system easier.

caller Someone who calls into Amanda. A caller often 
obtains information, leaves a message for someone, 
and/or provides information. 

user Someone with an extension that Amanda transfers 
calls to and/or stores messages for. A user can 
access Amanda to play, delete, and send messages 
as well as set all personal option, such as Do Not 
Disturb.



vi Using Amanda Portal Station
guest Someone without an extension that Amanda stores 
messages for. A guest can access Amanda to play, 
delete, and send messages as well as set some 
personal options, such as a pager number for 
notification.

File⇒ Logon... To show the selection of menu commands from 
menus, this book uses the name of the menu, 
followed by an arrow and the name of the 
command. For example, “select File⇒ Logon...” 
means open the File menu, then click the Logon... 
command.
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Chapter 1:
Installing Amanda Portal Station

Installing Amanda Portal clients is a simple process. The only decisions you 
have to make are about the installation folder, the name of the program 
group, and what clients to install. Amanda Portal has three clients:
• Amanda Portal Station for controlling your mailbox, routing incom-

ing calls, and managing the messages sent to or from your mailbox.
• CallQ Agent for processing incoming calls from a queue of calls to 

a team, for example, a customer support group.
• Amanda Portal Station Addition for the Amanda administrator.

System Requirements
To run these clients, you need one of the following operating systems:
• Windows 95 with Internet Explorer 5.0
• Windows 98
• Windows NT 4.0, Service Pack 5 or later
• Windows 2000, Service Pack 2

To install Amanda Portal clients:

1. From the CD ROM or a network location, start client.exe.

The Welcome dialog box opens.
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2. Click Next>.

The Select an Installation Folder dialog box opens.

3. Do one of the following:

• Use the default location (C:\AmaNTClients)

• Type or browse for a folder location.

4. Click Next>.

The Select the Clients dialog box opens.
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By default Amanda Portal Station is already selected. 

5. If you are an Amanda administrator, select the Amanda Portal Station 
Addition check box.

6. Depending on your job and your company, you may also need to select 
CallQ Agent.

Check with your administrator before installing this client.

7. Click Next>.

The Select a Program Group dialog box opens.

8. Use the default or type a new name for this program group.

9. Click Finish>.

The Installation Is Complete dialog box opens.

10. Click OK.
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Chapter 2:
Introducing Amanda Portal Station

Amanda Portal Station allows you to set up your Amanda mailbox and listen 
to your messages from you Windows workstation.

The guide is directed at the three types of people who will use Amanda 
Portal Station:

typical users Typical users manage only their own mailboxes and 
perhaps set up an occasional guest mailbox.

supervisors Those who supervise a group of Amanda users 
often manage their own mail boxes and those of the 
users that they supervise.

Amanda mailboxes are set up in a hierarchical or 
tree format. A supervisor’s mailbox is the parent of 
other users’ mailboxes. As the parent, it can provide 
and remove user privileges, lock portions of the 
user interface, and so on.

Amanda administrator The Amanda administrator is the owner of the 
administrator mailbox (usually 999). This mailbox 
is the root of the mailbox tree and can control any 
users’ mailboxes. Usually, the administrator creates 
and removes mailboxes that have telephone 
extensions and is in control of the extension plan 
for the company.
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The Administrator mailbox has all the available 
privileges and delegates them to supervisors and/or 
typical users.

The following figure shows Amanda Portal Station’s main window. The title 
bar shows:
• The name of the Amanda server (in this case, xanadu)
• The selected mailbox number (in this case 888)
• The name of the application: Amanda Portal Station

The window has two panes. The left pane shows the mailbox tree, with 999, 
the administrator’s mailbox as the root of the tree. For example, mailbox 888 
is a child of 999, and mailbox 116 is a child of 888. Mailboxes 999 and 888 
are ancestors of mailbox 116, and, in this case, the owners of mailboxes 999 
and 888 can control privileges, etc. for mailbox 116.

The right pane displays the icons for various parts of Amanda Portal 
Station’s interface. Depending on the privileges of the logged-on user, some 
of these icons may not be visible. Even when they are visible, portions of 
them may be locked.

The main window has a View menu from which you can adjust the splitter 
bar between the two panes and show or hide the toolbar and status bar.
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The Help menu allows you to use help for this product and to check version 
and copyright information.

Logging On and Off
To listen to messages, set options, and so on, you must be logged on to your 
mailbox on the Amanda server. You can log on from your workstation or 
from the telephone. From Amanda Portal Station, you can log on once for 
each connection you have to the Amanda server. This usually means you can 
log on to only one mailbox at a time.

To log on from your workstation:

1. Start Amanda Portal Station from the Start menu or from an icon on 
your desktop. 

The main window opens.

2. Do one of the following:

• Click Log On  on the toolbar.

• Select File⇒ Log On... from the menu bar.

The Log On dialog box opens.

3. Select the name of the server from the Remote Address list box.
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4. Type your mailbox number and security code in the appropriate boxes.

5. (Optional) Select the Remember Security Code check box if you don’t 
want to type in your security code every time you log on.

It is safest to leave this unchecked so others cannot access your mailbox.

6. Click OK.

TIP: To cancel a lengthy operation once you have logged on, se-
lect File⇒ Stop Waiting from the menu bar.

To log off, click Log Off  on the toolbar.

To exit, select File⇒ Exit from the menu bar. Exiting auto-
matically logs you off.

Using This Guide
Each icon in the right pane of the Amanda Portal Station main window has 
its own chapter. You should refer to the chapters for the icons of importance 
to you. The chapters are arranged alphabetically by the label beneath the 
icon. (The exceptions to this are the last three chapters, Administrative 
Mailbox Reports, Administrative Monitor, and Tcl Commands. They are not 
in the main window for most users, so they are at the end of the guide to 
avoid confusing anyone.)

The icons of importance to typical users are shown in the following table in 
the order you should probably use them when you first set up your mailbox.
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Icons Important to Typical Users
Icon Description

Security Code

One of the first things you do after you log on to Amanda Portal 
Stations is change your security code.
See “Chapter 15: Security Code” for more information.

Greetings

To use Amanda effectively, you must create some greetings for your 
caller’s to listen to when you do not answer your telephone and want 
the caller to leave a message. From the Greetings dialog box, you can 
also create a custom busy message and a name and extension 
message. The custom busy message plays when your telephone is 
busy. Amanda uses the name and extension message for several 
purposes.
See “Chapter 8: Greetings” for more information.

General
Information

Amanda needs to know your name, your extension, and the names to 
use for you in the public directory. When a caller uses the public 
directory, pressing the digits that represent the letters in your name 
results in Amanda telling the caller what number to dial for you.
Often the General Information dialog box is filled out for you by a 
supervisor or the Amanda administrator, but you need to check to be 
sure.
See “Chapter 7: General Information” for details.

Caller and User
      Options

You need to set the caller and user options because they are used to process 
your calls properly. For example, you use the caller options to let Amanda 
know that callers can be put on hold when your extension is busy. You use 
the user options to turn Screen Calls and Do Not Disturb on and off.
See “Chapter 4: Caller Options” and “Chapter 17: Logon Options” for more 
information.

Auto Scheduler

The Auto Scheduler lets you turn some of your user options on and off auto-
matically. For example, you might want Do Not Disturb turned on every 
evening after hours so that Amanda does not ring your extension. Then call-
ers can leave messages immediately.
See “Chapter 3: Automatic Scheduling” for more information.
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Supervisors have their own mailboxes and should be interested in all of the 
icons in the above table. The last three icons in that table should be more 
important to supervisors than to typical users because many supervisors:
• May need to decide what notifications a user needs
• Are very likely to create new mailboxes on a regular basis
• Usually check statistics regularly to see what employees are doing. 

Message Folders

You listen to, send, forward, and replay messages using Message 
Folders.
See “Chapter 11: Message Folders” for more information.

Member Lists

You use Member Lists to create mailing lists so that sending the same 
message to several users is more convenient.
See “Chapter 10: Member Lists” for more information.

Notification

When messages are left for you, you will want to be notified. Most 
of the notification processes are set up for you by others, but you 
make need to familiarize yourself with the notification dialog box.
See “Chapter 12: Notification” or more information.

Immediate 
Descendants

If you need to create a mailbox for a guest, you use Immediate 
Descendants. Few typical users will have this need, but you may 
want to familiarize yourself with this dialog box anyway.
See “Chapter 9: Immediate Descendants” for more information.

Statistics

The Statistics dialog box displays information about your mailbox, 
such as how many messages you have. Your supervisor may be more 
interested in these statistics, but you, too, might be curious about 
them.
See “Chapter 16: Statistics” for more information.

Icons Important to Typical Users (Continued)
Icon Description
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If the Amanda administrator set up mailbox templates with care, the 
Notifications icon may be less important to the supervisor because the 
notification records can be copied from a template to a new mailbox.

The first few icons in the next table may also be important to supervisors as 
they may need to:
• Set privileges for the mailboxes they create
• Add properties to a mailbox
• Change how incoming calls and user logons are processed
• Create some reports

However, these features as well as monitoring Amanda and using tcl 
commands are primarily of importance to the Amanda administrator.

Icons Important to Administrators
Icon Description

Privileges

Supervisors and administrators usually set privileges for the mail-
boxes they create.
See “Chapter 13: Privileges” for more information.

Extended Mailbox
Properties

Extended mailbox properties can be used to add additional functionality to 
Amanda. For example, you could set up voice over IP via a POP server.
See “Chapter 6: Extended Mailbox Properties” for more information.

Method 
Information

Tcl methods determine what happens when a call arrives, when a user logs 
on, and so on. Usually the Amanda administrator selects the methods that 
should be used for each mailbox template. Sometimes the administrator or 
supervisor need to adjust these.
See “Chapter 5: Chain Information” for details.
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Phonics

Amanda might need a variety of pronunciations for users’ names, etc.
See “Chapter 14: Using Phonics.”.

Administrative 
Mailbox Reports

Creating reports on Amanda usage are usually an important part of the 
Amanda administrator’s job.
See “Chapter 18: Administrative Reports” for more information.

Administrative 
Monitor

Monitoring the Amanda server is critical to the smooth operation of 
the Amanda system.
See “Chapter 19: Administrative Monitor” for more information.

Tcl Command

The Amanda administrator might write tcl methods from time to time 
and need to test them.
See “Chapter 20: Tcl Command” for more information.

Icons Important to Administrators (Continued)
Icon Description
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Automatic Scheduling

Schedules automatically change how Amanda processes calls. For example, 
you can change:
• The number of rings before a call is considered unanswered
• The greeting the caller hears when the call is not answered
• The Do Not Disturb option
• The Call Screening option
• Other tcl code

You can schedule the changes to take place only once or at regular intervals 
after a specified starting date and time. You also select the days of the week 
on which Amanda can or cannot execute the schedules.

For example, you can define a schedule for the Company Greeting mailbox 
(990) that tells Amanda to start playing your company’s daytime greeting in 
the morning on weekdays and another that tells Amanda to start playing your 
after-hours greeting in the evening on weekdays.

Amanda allows you to create any number of schedules for each mailbox 
under your control. 

Amanda executes schedules exactly as instructed—whether or not the 
change makes any sense. However, if the date to repeat a schedule falls on an 
invalid day, Amanda waits for a valid day before executing the schedule. 
(Amanda does this by adding one day to the execution date until the date 
finally falls on a valid day.) For example, suppose you schedule a change to 
occur every 48 hours, but not on weekends. If a 48-hour period ends on a 
Saturday, Amanda waits a day and tries to execute the schedule again on 
Sunday. Because Sunday is also an invalid day, Amanda waits another day 
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and executes the schedule on Monday. From the execution time on Monday, 
Amanda starts the next 48-hour period.

Some of the options that a schedule controls can be changed by users from 
their telephones or by using Amanda Messenger. For example, users can 
change their greetings and Do Not Disturb options (unless you have them 
locked). 

For example, users can change their greetings and set their Do Not Disturb 
options every night as they go home and every morning as they return. 
However, if they keep regular hours, having schedules is much more 
convenient. 

Creating Schedules
When you create a schedule, you specify both what the schedule does and 
under what conditions it can be executed.

To create a schedule:

1. From the Amanda Portal Station window, select the mailbox to be 
scheduled from the mailbox tree.

2. Click the Auto Scheduler  icon.
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The Auto Scheduler dialog box appears. 

The schedules are numbered, starting with 1. If you see a 0 in the Sched-
ule spin box, no schedules exist for this mailbox.

3. If you do not see a 0 in the Schedule spin box, an existing schedule 
appears in the dialog box.

If you already have several schedules, one might be very similar to the 
one you are creating. Starting with it can save you time.

4. (Optional.) Click Clear to reset the entire dialog box to its default set-
tings—unless you want to use the existing settings.
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5. Click Create to immediately start a new schedule with the current sched-
ule’s settings.

If you don’t click Create at this point, you could accidentally edit an 
existing schedule (by clicking OK or Apply).

6. After settings all the options on the dialog box, you will click Apply to 
update this new schedule with those new settings.

Setting Schedule Options
1. From the Auto Scheduler dialog box, select a priority level for this 

schedule.

Give higher priorities to schedules that override other schedules that 
execute at the same time. For example, if an employee is on vacation, 
the greeting that explains that the called party is unavailable until a cer-
tain date or that explains to the caller that the call is being rerouted to an 
assistant should have a higher priority than the others (and actually over-
ride the others) for the days that the employee is out of the office. For 
example, this might be priority 1.

If there are three schedules that are executed daily, make them all the 
same priority so that they cannot override one another. For example, 
these might be priority 2.

2. Go to the Initial Time tab.

3. Select the starting date and time for this schedule using the calendar, the 
month, and year drop-down list boxes, and the time spin box.

The default is the current date and time.

TIP: Depending on where your cursor is in the Time spin 
box, the spin buttons change the hour, the minutes, or 
the setting for A.M./P.M.

The Next Time tab is set automatically when you select 
the settings for the Execute Every tab. You never select 
settings for a schedule using the Next Time tab. It is for 
reference purposes only. Use it to double-check that 
you have set the interval correctly using the Execute 
Every tab.



Chapter 3: Automatic Scheduling 17
4. To indicate the days of the week on which this schedule can be exe-
cuted, select or clear the check boxes (labeled Sunday through Satur-
day) in the Restrict To Days... group box.

For example, if a greeting is to play only on US Thanksgiving, you 
would click the Thursday check box.

5. Use the Execute Every tab to indicate how often the schedule will be 
executed. Select one of the following and a number to go with it:

For example, if a greeting is to play only each year on US Thanks-
giving, the interval should be 11 months and 29 days.

If the schedule is to be executed only once ever, use all zeros in the 
spin boxes on the Execute Every tab.

6. The Method group box is for tcl commands that executes an existing 
method (or the actual tcl method itself). 
a. Use the On tab for the method that performs an operation, such 

as changing a greeting, during the normal execution of the 
schedule.

It is best to use existing methods because several mailboxes can use 
that same method. Click Existing Method... to create or select a 
method.

For more information, see “Adding a Method” on page 28 or “Cre-
ating a Method” on page 30.

b. (Optional) Use the Off tab for the method that executes only 
once—when the schedule’s duration time has been reached.

Select: Interval Between Executions:

Years Use 1 for annually or x for every x years.

Months Use 1 monthly or x for every x months.

Days Use 1 for daily or x for every x days.

Hours Use 1 for hourly or x for every x hours.

Minutes Use x for every x minutes.



18 Using Amanda Portal Station
It is best to use existing methods because several mailboxes can use 
that same method. Click Existing Method... to create or select a 
method.

7. (Optional.) Set a duration for schedules that are temporary. For example, 
while an employee is on vacation, the mailbox may direct the caller to 
another employee, but only for 14 days.
a. Click the Duration tab.
b. Type a number of years, months, days, hours, and/or minutes.

If you do not set a Duration interval, the schedule with be executed 
indefinitely. 

8. Do one of the following:

• Click Create to create a new schedule.

• Click Apply to update the existing schedule.

TIP: Click Clear to restart if you have made mistakes with this 
schedule and need to start over.

Editing Schedules
You can edit schedules when necessary. For example, the duration might 
need to be extended or you might what to change the method being used.

To edit a schedule:

1. From the Amanda Portal Station window, select the mailbox to be 
scheduled from the mailbox tree.

2. Click the Auto Scheduler  icon.
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The Auto Scheduler dialog box appears. 

The schedules are numbered, starting with 1. If you see a 0 in the Sched-
ule spin box, no schedules exist for this mailbox.

3. Select the number of the schedule to be edited from the Schedule spin 
box.

4. After settings all the options on the dialog box, you will click Apply to 
update this new schedule with those new settings.

See “Setting Schedule Options” on page 16 for details about each 
option.
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Deleting a Schedule
You can delete schedules.

To disable a schedule:

1. From the Amanda Portal Station window, select the mailbox to be 
scheduled from the mailbox tree.

2. Click the Auto Scheduler  icon.

The Auto Scheduler dialog box appears.

Notes for Administrators
schedules automate one or more call-processing or other mailbox changes 
for a user. Schedules are created:
• When the mailbox is created (by copying the schedules that already 

exist in the mailbox on which the new mailbox is based)
• By you, one-by-one, as needed

Managing schedules includes:
• Creating and modifying schedules
• Making the schedules needed by most or all users part of the mail-

box template (by default mailbox 997).

For example, if most employees work from 8 A.M. to 5 P.M., you can 
create a schedule that turns Do Not Disturb on in the evening. Then 
after-hours callers do not have to wait while the telephone rings the 
maximum number of times. They hear the user’s RNA (Ring No 
Answer) greeting immediately. A second schedule must turn Do Not 
Disturb off in the morning. If all employees use Greeting 1 as a work 
hours greeting and Greeting 2 as an after-hours greeting, these same two 
schedules can also change the RNA greeting from 1 to 2 and back again.

• Testing schedules to verify that the expected call-processing chang-
es do take place.

When testing a schedule, check whether Amanda makes the correct 
changes by changing the schedule’s effective date and time. Do not 
adjust the Time… option. For example, you can put the schedule into 
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effect five minutes from now rather than tomorrow morning, then call 
the user’s mailbox to see if his greeting (or whatever) has changed.

 CAUTION: The locks block changes made by users via the 
telephone or Amanda Portal Station only.

• Editing schedules.

Be aware that editing a schedule for mailbox 997 does not update that 
schedule for mailboxes previously created as copies of mailbox 997. If 
affects mailboxes that will be created in the future but not the existing 
mailboxes. Existing copies of this schedule would each have to be 
edited separately.

However, if you edit a method that is used by a number of mailboxes, 
they all use the updated method.
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Chapter 4:
Caller Options

You can view and change the settings for your mailbox’s caller options. 
Amanda Portal Station is normally set up to use these settings to control how 
your mailbox interacts with your callers, but your settings may be ignored or 
overridden. If you cannot change one or more options, you may not have the 
privilege to do. See your system administrator.
Some options can be changed using the telephone. For more information, see 
Using Amanda Portal Telephone Features.

To view caller options:

1. From the Amanda Portal Station window, select a mailbox from the 
mailbox tree.

2. Click the Caller Options icon: 
The Caller Options dialog box displays the options described in the fol-
lowing table.
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Caller Options
Option Description

Abbreviate “Leave 
message” prompt

When this check box is selected, Amanda says, “Please leave a message at 
the tone.” This is the shortened version of the system greeting.
When cleared, Amanda says, “Please leave a message for” followed by the 
name and extension recording. This is the usual default version of the system 
greeting.
This option is of no interest to you if you create your own greetings for call-
ers.

Allow caller to hold 
while extension is 
busy

When this check box is selected, the caller can press * to hold for a busy ex-
tension. 
When cleared, a busy signal at your telephone is managed the same way as a 
Ring No Answer (RNA) call. That means that the caller cannot hold for a 
busy extension and can only leave a message once RNA or BUSY is the state 
of the called extension (assuming the mailbox accepts messages).

Play “Please hold” 
prompt

When this check box is selected, Amanda says “Please hold while I try that 
extension” before transferring a caller. 
When cleared, Amanda says nothing and immediately puts the caller on 
transfer hold.

Play “Begin record-
ing at the tone” 
prompt

When this check box is selected, Amanda plays, “Begin recording at the 
tone, finish by pressing # or hanging up” before the beep. 
When cleared, the caller hears only a beep.

Play Post-record 
menu

When this check box is selected, the caller hears the post-record menu, a 
menu that allows callers to review and/or re-record their messages.
When cleared, the caller does not hear the menu.

Ring No Answer 
after x rings

Type the number of times the telephone should ring before the caller 
hears your greeting. For example, the default is 4, allowing you four 
rings to answer the telephone.
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Chain Information

Tcl methods control how Amanda processes incoming calls and users 
logging on to their mailboxes on a per mailbox basis. For each mailbox, you 
supply a method that determines what Amanda does when:

• A caller requests the mailbox

- The call is considered complete (for example, perhaps you want the 
caller to hear the main menu again and be allowed to speak with 
another user)

- The user does not answer the call

- The called extension is busy

- The caller presses a digit in response to a menu

• A user logs on to the mailbox

To control calls and logons:

1. From the Amanda Portal Station window, select a mailbox from the 
mailbox tree.

2. Click the Chain Information icon: 
The Methods dialog box has a tab for each method.
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There are more tabs than can be displayed at one time. 

Click the scroll buttons at the end of the tab display to show additional 
tabs in either direction.

When this dialog box is unlocked, you can type tcl commands directly 
into the tabbed text boxes or you can select one existing method for each 
text box by clicking Existing Method.... 

Adding an existing method replaces all the text currently in the text box 
with the name of the new method. You can add text above or below the 
new method.

The following table explains when the tcl commands or the method in 
each tab are executed.

If the dialog box is locked, you might not have permission to unlock it. 
See your Amanda administrator or your supervisor for details.
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Method Explanation

Caller Method As a call comes in for a particular mailbox, Amanda processes the 
Caller method for that mailbox. This method usually applies the call-
er and user option settings. (For example, the method would process 
the call differently if Do Not Disturb is on than if it is off.)

User Method As a user logs on to a mailbox, Amanda processes the User method 
for that mailbox. For example, a menu would let the user know what 
number to press for what services, and so on.

Done Method After Amanda finishes processing an incoming call, Amanda pro-
cesses the Done Method. If it is blank, Amanda uses the Done Meth-
od of the company greeting mailbox (usually mailbox 990). The 
Done Method for the company greeting mailbox normally instructs 
Amanda to process the caller method for caller instructions mailbox 
(usually mailbox 991) so that the caller hears the main menu once 
more and can ask for additional users.

RNA Method If a dialed extension returns Ring No Answer, Amanda processes the 
RNA Method. For example, the method might instruct Amanda to 
play the mailbox’s greeting and take a message or process another 
mailbox’s caller method.

Busy Method If a dialed extension is busy, Amanda processes the Busy Method. 
For example, the method might instruct Amanda to play the mail-
box’s busy message and either place the caller on hold or take a mes-
sage. It might instruct Amanda to process another mailbox’s caller 
method.
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Adding a Method
You can type tcl commands directly into the space allowed for each tab or 
add an existing method using the following procedure. Your Amanda system 
comes with the canned methods shown in the table at the end of this section.

To add a method:

1. From the Methods dialog box, select the appropriate tab, for example, 
Caller Method.

2. Click Existing Method....

The Existing Method List dialog box displays a list of methods. Some 
can be edited and some cannot. Those that can be edited come from the 
persistent method database. Those that cannot be edited belong to the 
Amanda server and can only be edited from the server.

Menu0 through 
Menu9

Menu0 though menu9 allow you to provide callers with a menu. 
Menu0 through menu9 indicate what happens when the caller presses 
the digits 0 through 9 in response to a menu. For example, the menu3 
method might instruct Amanda to play an additional greeting (pro-
viding information to the caller) while the menu7 method processes 
the caller method for another mailbox. If a menu method is blank, 
Amanda assumes that the digit is another mailbox number (or part of 
the number) and processes the caller method for that mailbox. For ex-
ample, if menu0 is blank and 0 is the operator’s mailbox, Amanda di-
als the operator.
The mailbox’s greeting tells the caller what the menu options are. 
The caller must respond during the greeting or during the delay that 
follows.

Method Explanation
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3. Select an existing method from the Method Name list box.

4. Some existing methods expect you to supply arguments to be used by 
the method when it is executed for this mailbox. 

The fact that the Arguments text box is enabled (that is, you can type in 
it) means that the method is from the persistent method database and can 
be edited. It does not necessarily mean that arguments are expected; 
check the method to be sure.

When using arguments, separate the arguments with spaces.

5. Click OK.
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Creating a Method
This user’s guide does not provide any information about writing tcl. There 
are numerous available materials on the subject. However, the following 
procedure explains how to add a tcl method to the list of existing methods.

You can create methods only when the Existing Method List dialog box 
dialog box is unlocked. If it is locked and you cannot unlock it, see your 
Amanda administrator for the necessary change in your privileges.

To create a method:

1. From the Methods dialog box, select the appropriate tab, for example, 
Caller Method.

2. Click Existing Method....

The Existing Method List dialog box opens.

3. Click Create....

The Existing Method Name dialog box opens.

4. Type a name for this method in the Name text box.

5. Click OK.

The Existing Method List dialog box reappears.

6. Click Edit....

Notepad or another default editor opens.

7. Type the body of the method, save it, and exit Notepad.

An Amanda Portal Station message asks you if you want to apply the 
changes.

8. Click Yes.

The Existing Method List dialog box reappears, now displaying your 
method in the Body text box.
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9. If the method requires arguments, type them in the Arguments text box. 
Separate your arguments with spaces.

10. Do one of the following:

• Click OK to assign the new method to the selected tab in the Chain 
Information dialog box.

• Click Apply to save your arguments and stay in the Existing 
Method List dialog box where you can create and edit other meth-
ods. Make sure you select the correct method for the selected tab 
before you click OK.

Renaming a Method
1. From the Methods dialog box, select the appropriate tab, for example, 

Caller Method.

2. Click Existing Method....

The Existing Method List dialog box opens.

3. Select the method to be renamed from the Name list box.

4. Click Rename....

The Existing Method Name dialog box opens.

5. Type a new name for this method in the Name text box.

6. Click OK.

The Existing Method List dialog box reappears.

7. Do one of the following:

• Click OK to assign the renamed method to the selected tab in the 
Chain Information dialog box.

• Stay in the Existing Method List dialog box where you can create 
and edit other methods, making sure you select the correct method 
for the selected tab before you click OK.
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Deleting an Existing Method
1. From the Methods dialog box, select the appropriate tab, for example, 

Caller Method.

2. Click Existing Method....

The Existing Method List dialog box opens.

3. Select the method to be deleted from the Name list box.

4. Click Delete.

5. Click Yes to confirm the deletion.
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Extended Mailbox Properties

You can add new properties to mailboxes as well as the setting for them. 
Then you can write methods, etc. that use those properties and their settings. 
For example, if you wanted to do voice over IP via a POP server, you would 
need a property for the name of the POP server.

There are numerous applications you can add to Amanda mailboxes in this 
way.

To add your own mailbox properties:

1. From the Amanda Portal Station window, select a mailbox from the 
mailbox tree.

2. Click the Extended Mailbox Properties icon: 
The Extended Mailbox Properties dialog box opens.
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There is no way to lock these properties, but you can control whether or 
not they can be deleted and who is allowed to modify them.

Creating Mailbox Properties
Depending on what additional processing you want to provide for a mailbox, 
you may need additional properties.

To create a mailbox property and set it:

1. From the Extended Mailbox Properties dialog box, click Create....

The Extended Mailbox Property dialog box opens.

2. Type a name in the Property Name text box.

3. Type a value in the Value text box.

4. Select an Accessibility option button to determine who can edit this 
property:

• Select Read-only if no one can edit this property.

• Select Only Ancestor Writes if the owner of this mailbox cannot 
change the value, but the owner of its ancestor mailboxes can.

• Select Read/Write if the owner of this mailbox and its ancestor 
mailboxes can edit this property.
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5. Select or clear the Deletable check box to allow the property to be 
deleted or not.

Be careful with your choice here as it cannot be changed except by the 
Amanda administrator.

6. Click OK.

Editing Mailbox Properties
Depending on the accessibility options set for a given property, you may or 
may not be able to change its value.

To change a mailbox property’s value:

1. From the Extended Mailbox Properties dialog box, click Edit....

The Extended Mailbox Property dialog box opens.

2. Type a new value in the Value text box.

3. Click OK.
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Deleting Mailbox Properties
Depending on the deletability setting for a given property, you may or may 
not be able to delete a mailbox property. When logged on to the 
administrator mailbox (usually 999), you can delete even non-deletable 
properties.

To delete a mailbox property:

1. From the Extended Mailbox Properties dialog box, click Delete.

2.  Click Yes to confirm the deletion.
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General Information

Amanda needs general information about the owner of each mailbox. For 
example:
• What is this user’s name?

Amanda can provide prompts in more than one language.
• How should this user’s name be spelled for the public directory?
• At what extension and on what NT server can this user be called?

To set general information options:

1. From the Amanda Portal Station window, select the mailbox from the 
mailbox tree whose general information is to be changed.

2. Click the General Information icon: 
The General Information dialog box opens.
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The user is always allowed to change the name, name and extension 
message, comment about this mailbox, or the language to be used.

Administrators can grant or deny a user access to the public directory and the 
telephone location information so those parts of this dialog box may be 
locked. If you cannot unlock these and need to, see your Amanda administer.

Providing the User’s Name
Amanda needs to know the name of the mailbox’s owner in both a text and a 
recorded format.

The text name, for example, Chris Wang, appears in a number of lists.

The recorded name should include the extension number and is referred to as 
the name and extension message. 
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The name option is never locked; the user can change it at any time.

To provide a user with a name and a name and extension message:

1. From the General Information dialog box, type a name in the Name text 
box.

2. (Optional) Type a comment about this dialog box for future reference.

3. To record, re-record, or import a file containing the name and extension 
message, click Edit Message...

The Edit Multimedia Object dialog box opens.

See the directions for creating audio files from this dialog box in “Creat-
ing a Personal Greeting” on page 47.

For more information about the name and extension message and 
another way to record it, see “Name and Extension Message” on 
page 46 and “Creating a Name and Extension Message” on page 52.

4. Click OK when done to return to the General Information dialog box.

Adding a User to a Directory
A user can be listed in any number of directories. By default, the only 
directory is 411, the public directory, but you can create others.

Within a directory, a user can be listed with any number of names. For 
example, if a user named Thomas is called Tom by his friends, he should 
probably be listed as both Thomas and Tom as well as by his last name. If a 
woman gets married and takes her husband’s name, she probably should be 
listed by both her current last name and her maiden name—at least for a 
while. If the CEO of a company doesn’t want to be contacted by random 
callers, the CEO should have no listing in the public directory.

When callers say the name or the extension number of the person they want 
to talk to, Amanda matches up what they say with the entries in the public 
directory or with an extension number.
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Then Amanda does one of the following:

• Connects the call to the called party

• Asks the caller to differentiate among possible matches and then 
connects the call

• Connects the caller to the operator because there is no match

For example, suppose a user’s name is Eric Toshari, you might list him in the 
public directory as Eric, Eric Toshari, and Toshari. 

To add names to a directory:

1. From the General Information dialog box, select the directory from the 
Directory drop-down list box.

For example, the public directory is 411.

2. Click Add Name....

The Add New Directory Name dialog box opens.

3. Type a name for this user.

4. Click Phonics... to listen to the name pronounced and correct the pro-
nunciation as necessary.

The Word Pronunciation Teacher dialog box opens.
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5. Click Speak to listen to the name.

6. To get a better pronunciation, adjust the pronunciation by selecting pho-
nemes from the American English Phoneme Table list box or typing 
phonemes in the Phoneme text box.

To use the list box:
a. Place the cursor in the Phoneme text box at the location where 

the phoneme should be inserted.
b. Double-click a phoneme in the list box to places the letters for 

that phoneme in the Phoneme text box at the cursor’s location.

7. Repeat steps 5 and 6 as necessary.

8. Click Finish to return to the Add New Directory Name dialog box.
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9. Click OK.

10. Repeat steps 1 through 9 for each additional names.

TIPS: If you type the name incorrectly or need to change the 
pronunciation, you can select the name from the Public 
Directory Entries list box and click Edit Name....

To delete the name, click Delete Name.

For more information about phonetic pronunciation and 
using phonemes, see “Chapter 13: Using Phonics.”

If you have the correct privileges, you can lock this option 
for your descendants (but not for yourself).

Creating Additional Directories
The default public directory is named 411 and uses mailbox 411. However, 
you can create other directories for other purposes.

To create a directory:

1. From the General Information dialog box, click Create Directory....

The Directory Database Name dialog box opens.

2. Type the name of the new directory.

3. Click OK.

TIP: To get rid of a directory, select it from the Directory drop-
down list box. Then click Delete Directory and confirm.

If you have the correct privileges, you can lock this option 
for your descendants (but not for yourself).



Chapter 8:
Greetings

Greetings are recordings played by Amanda for a variety of uses. There are 
system greetings for:
• When you do not answer your telephone
• When your telephone is busy
• When you transfer a call

Because the system greetings are generic and impersonal, your Amanda 
system administrator usually allows you to record (or import files for) any 
number of personal greetings as well as a custom busy greeting. Be aware 
that only the first seven greetings can be accessed using the telephone user 
interface.

Then, when you do not answer your telephone, Amanda plays your current 
greeting. When your extension is busy, Amanda plays your custom busy 
greeting.

If you are screening calls from your workstation, you control which greeting 
the caller hears as you transfer the call, put the caller on hold, or ask the 
caller to leave a message.
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Sample Greetings
This section contains sample greetings for a variety of occasions. It is 
important that each greeting be as informative as possible.

Work-hours Greeting
When Amanda rings your extension and you do not answer, the caller hears a 
greeting. For example, you can have a daytime greeting, an after-hours 
greeting, and a vacation or on-the-road greeting. Until you record a greeting, 
Amanda plays the system greeting, “Please leave a message for,” followed 
by your name and extension message. (If you have not recorded the name 
and extension message, Amanda plays your mailbox number.)

For example: “This is Chris. I’m away from my desk or on another line. You 
can bypass this greeting by pressing the # sign twice. To speak to someone 
else right now, enter that person’s extension or press 0 for assistance. If you 
leave me a detailed message at the tone, I’ll get back to you as soon as 
possible.”

These greetings can be manually selected by you or they can be scheduled by 
you or the owner of a mailbox that is the ancestor of your mailbox.

After-hours Greeting
Many Amanda administrators set up each mailbox so that greeting 1 plays 
for routine working hours and greeting 2 plays for after-hours calls. Here is 
an example:

“You have reached the office of Chris Wang at Homestead, Inc. after hours. 
No one at Homestead can answer your call right now. Leave a detailed 
message at the tone, or call during office hours: 10 A.M. to 6 P.M., Monday 
through Friday.”
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Away-from-the-office Greetings
“Chris Wang of Homestead, Inc. will be out of town until Monday, May 5th. 
While I am gone, my associate, Matthew Lee, is handling all my business 
calls. Please call Matthew at Extension 557. I will be unable to check my 
messages until I return.”

“Chris Wang of Homestead, Inc. will be off-site until Monday, May 5th. 
While I am gone, my associate, Matthew Lee, is handling my business calls. 
Please call Matthew at Extension 557 or leave me a message. I will be 
checking my messages daily.”

Your messages can be copied to you and/or other coworkers while you are 
on vacation. (The message copying can be stopped when you return.) If 
someone else is getting your messages, you might want to use the following 
greeting:

“Chris Wang of Homestead, Inc. will be out of town until Monday, May 5th. 
My associate, Matthew Lee, is handling all my business calls. Call Matthew 
at Extension 557 or leave him a detailed message at the tone.”

Custom Busy Greeting
By default, Amanda plays a system busy greeting when your telephone is 
busy—unless you are screening calls.

If your Amanda system administrator allows custom busy greetings, you can 
create a more personalized busy greeting. When you turn the custom busy 
greeting on, callers hear it instead of the system busy greeting.

For example:  “This is Chris. I’m talking to someone else at the moment. 
Press * to hold, enter another extension, or stay on the line to leave me a 
message.”

This is not one of your personal greetings, so to create and record it, you 
must select the Show Non-greeting Multimedia Objects (MMOs) check box.
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Name and Extension Message
Amanda plays the name and extension message (a recording of your name 
followed by your extension number) in a variety of important situations:
• When a caller uses the employee directory to enter that user’s name.
• As part of the system RNA (Ring No Answer) greeting. Amanda 

uses the system greeting when no personal greeting is recorded or al-
lowed.

• When one user replies to a message from another user.
• When a user reviews the list of the mailboxes that are the descen-

dants of his or her mailbox.

Example:  “Chris Wang. Extension 247.”

If a mailbox does not have an name and extension message, the system 
greeting consists of the word “extension” and the digits in the extension, for 
example, “Extension 2-4-7.” This is not very useful to callers, so it is 
important that you record this message.

This is not one of your personal greetings, so to create and record it, you 
must select the Show Non-greeting Multimedia Objects (MMOs) check box.

Managing Your Greetings
You manage, create, and edit greetings from the Greetings dialog box.

To manage greetings:

1. From the Amanda Portal Station window, select the mailbox from the 
mailbox tree.

2. Click the Greetings icon: 
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The Greetings dialog box opens.

If the dialog box is locked, you might not have permission to unlock it. 
See your Amanda administrator for details. For more information about 
locks, see “Understanding Locks” on page 116.

Creating a Personal Greeting
A personal greeting cannot exceed the length set by your Amanda system 
administrator. By default, this is an unlimited number of seconds. 

Parts of the following procedure can also be used to change the name of or 
listen to a greeting.
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To create a personal greeting:

1. From the Greetings dialog box, select Greetings from the MMO Type 
drop-down list box.

2. Click Create....

The Edit Greeting or Non-greeting dialog box opens.

3. Type a number for this greeting in the Number text box.

4. Select a language from the drop-down list box.

Amanda combines the values for number and language to create the key 
that appears in the Greetings dialog box.

5. Type a description of this greeting in the Description text box.

This description is used to identify this greeting elsewhere so use a 
description that clearly distinguishes this greeting from others. by 
default, this description can contain up to 60 characters, but the Amanda 
administrator might change that length.

6. Click Edit MMO....
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The Edit Multimedia Object dialog box opens.

7. Follow the steps in one of the procedures below. They explain how to 
record a greeting, import a file as a greeting (for example, a .WAV file), 
or use a cached multimedia object (MMO) as a greeting. A cached 
MMO is an MMO that is stored in a cache on your workstation because 
you referenced it recently. For example, this could be any audio file, a 
message or greeting, you have listened to recently.

To record a greeting from your workstation:
a. From the Source group box, select the Create New option but-

ton.

By default, Amanda expects you to be recording a .WAV file which 
Amanda will store appropriately. This is usually a Mulaw format.

b. (Optional) If you will not be creating a .WAV file or your sys-
tem stores formats other than the default, select the Enable Ad-
vanced Formats check box; then select a different audio format 
from either the From or To list box or from both list boxes.

NOTE: The type Wave is either Wave 8 bit or Wave 16 
bit, depending on what works best with your sys-
tem. 

c. Click OK.

The Sound Recorder (or a similar application) starts.
d. Record the greeting, save the file, then exit the recording appli-

cation.
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Amanda asks if you want to apply these changes to your greeting.
e. Click Yes to return to the Edit Multimedia Object dialog box.
f. Click OK to return to the Greetings dialog box.

To import a greeting:
a. From the Source group box, select the Import option button then 

click OK.

The Windows standard Open dialog box opens.
b. Select an audio file, usually a .WAV file, to import then click 

Open.
c. The Confirm Import File Type dialog box opens.

d. The From drop-down list box should display the type of the file 
you imported. Correct it if wrong type appears.

e. From the To drop-down list box, you can select a file type for 
storing your greeting. By default, Amanda should select the type 
(usually Mulaw format) used by the Amanda system.

f. Click OK to return to the Greetings dialog box.

To use a cached multimedia object (MMO) as a greeting:
a. From the Source group box, select the Cached MMOs option 

button.

The Component List dialog box lists the MMOs in the cache. 
Objects in the cache are files that you have created or listened to 
recently. 
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b. Select an object.
c. (Optional) Click Review to listen to or display the object.
d. Click OK to return to the Edit Multimedia Object dialog box.
e. Click OK to return to the Greetings dialog box.

NOTE: You cannot immediately set a newly created greeting as the 
current greeting. You must exit the Greetings dialog box 
and reopen it (or select another MMO type, then return to 
Greeting as the MMO type) to see the new greeting in the 
Current Greeting drop-down list box.

Creating a Custom Busy Greeting
A custom busy greeting can replace the system busy greeting that your 
callers hear when your extension is busy. It cannot exceed the length set by 
your Amanda system administrator. By default, this is an unlimited number 
of seconds.

To create a custom busy greeting:

1. From the Greetings dialog box, select Busy Greeting from the MMO 
Type drop-down list box.

2. Select Custom Busy from the list box.

3. Click Edit....
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The Edit Greeting or Non-greeting dialog box opens.

4. Click Edit MMO....

5. Follow the steps in one of the procedures provided for creating greetings 
“Creating a Personal Greeting” on page 47. They explain how to record, 
import, or use a cached object as the greeting.

Creating a Name and Extension Message
A name and extension message lets callers and others know your name and 
extension number. It cannot exceed the length set by your Amanda system 
administrator. By default, this is an unlimited number of seconds. 

To create a name and extension message:

1. From the Greetings dialog box, select Name And Extension from the 
MMO Type drop-down list box.

2. Select Name from the list box.

3. Click Edit....
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The Edit Greeting or Non-greeting dialog box opens.

4. Click Edit MMO....

5. Follow the steps in one of the procedures provided for creating greetings 
“Creating a Personal Greeting” on page 47. They explain how to record, 
import, or use a cached object as an MMO.

Editing a Greeting or Name and Extension Message
Editing a personal greeting, custom busy greeting, or name and extension 
message is a matter of re-recording it or replacing it with an imported file or 
a cached multimedia object (MMO).

To edit a greeting or name and extension message:

1. From the Greetings dialog box, select one of the following from the 
MMO Type drop-down list box.

• Greetings (for a personal greeting)

• Busy Greeting (for the custom busy greeting)

• Name and Extension (for the name and extension message)

2. Select the greeting or message from the list box.

Select personal greetings by their descriptions. Select Custom Busy for 
the custom busy greeting or Name for the name and extension message.

3. Click Edit....
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The Edit Greeting or Non-greeting dialog box opens.

4. Click Edit MMO....

5. Follow the steps in one of the procedures provided for creating greetings 
“Creating a Personal Greeting” on page 47. They explain how to record, 
import, or use a cached object as an MMO.

NOTE: Some of your changes are not visible immediately. For ex-
ample, if you change the description, you must exit the 
Greetings dialog box and reopen it (or select another MMO 
type, then return to Greeting as the MMO type) to see the 
new description.

Reviewing a Greeting
To review a greeting, follow the directions for editing a greeting, but listen to 
it rather than re-record it.

Setting Your Current Greeting
When you do not answer your telephone, Amanda usually asks the caller to 
leave a message. You can create one or more greetings for this purpose or use 
the system greeting as your current greeting. If you have no greetings, 
Amanda uses the system greeting (“Please leave a message for” followed by 
the Name/Extension message for your mailbox).

You can change the current greeting using either Amanda Portal Station or 
your telephone. For example, you can change from your usual greeting to a 
vacation greeting or from a work-hours greeting to an after-hours greeting.
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If you use several greetings, for example, one for during the day and another 
for nights and weekends, you might prefer to schedule when your mailbox 
should switch from one greeting to another.

To select the current greeting:

1. From the Greetings dialog box, select Greetings from the MMO Type 
drop-down list box.

2. Select a greeting (by description) from the Current Greeting drop-down 
list box.

3. (Optional) Set a number of seconds in the Response Delay text box.

Amanda waits this number of milliseconds before taking a message or 
executing an appropriate method. If your greeting contains a menu, the 
caller may need a few seconds to make a decision after hearing the 
greeting to make a selection. Amanda accepts menu selections while the 
greeting is playing and during the milliseconds of delay then executes 
the method associated with that menu selection.

NOTE: You can schedule changes to the current greeting. For ex-
ample, you can schedule one greeting to play during the 
work day and another to play after hours. See “Chapter 3: 
Automatic Scheduling.”

Using a Custom Busy Greeting
You can use either the system busy greeting or a custom busy greeting to let 
the caller know that the dialed extension is busy. The system busy greeting 
allows the caller to hold for the extension by pressing *, which, in turn, 
causes Amanda to play the Busy-Hold music file (about 30 seconds of 
custom music) before trying the extension again. If the extension is still 
busy, Amanda changes her prompt, allowing the caller to continue holding, 
enter another extension, or leave a message.

To use the system or custom busy greeting:

1. From the Greetings dialog box, select Busy Greeting from the MMO 
Type drop-down list box.



56 Using Amanda Portal Station
2. Do one of the following:

• Select the Use Custom Busy check box to use your custom busy 
greeting.

• Clear the Use Custom Busy check box to use the system busy greet-
ing.

3. Click OK.

Managing Non-greeting MMOs
The Greetings dialog box can be used to record and store multimedia objects 
(MMOs) that are not one of your personal greetings. For example, folder and 
member list descriptions are considered non-greetings.

To manage non-greeting MMOs:

1. From the Greetings dialog box, select one of the following from the 
MMO Type drop-down list box.

• Folder Descriptions (for a audio folder descriptions)

• List Descriptions (for a audio descriptions of member/mailing lists)

• Other (for other MMOs)
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2. Select an item from the list box then click Edit....

3. You create and edit non-greetings in the same way that you create and 
edit personal greetings.

See “Creating a Personal Greeting” on page 47 for details.

The only difference in managing greetings and non-greetings is that the Edit 
Greeting or Non-greeting dialog box is missing the Language list box.
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Notes for Administrators
This section covers some advanced issues related to greetings.

Setting Greeting Time Limits
If you are setting up a descendant mailbox, you can limit the length of the 
greetings its owner records. All greetings are cut off if they exceed the time 
limit.

To limit the time that a greeting will play:

1. Log on as the administrator (mailbox 999).

2. From the Amanda Portal Station window, select the mailbox from the 
mailbox tree.

3. Click the Greetings icon: 

4. From the Greetings dialog box, do one of the following:

• Type a number of seconds in the Maximum Length text box.

• Select the Infinite check box to allow the entire greeting to play 
regardless of its length.

TIP: If you set this correctly for mailbox 997, from which most 
mailboxes are copied, you won’t have to set it for other 
mailboxes.
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Immediate Descendants

You may be allowed to create additional mailboxes on the Amanda system. 
There are two types of mailboxes: guest and non-guest. The non-guest 
mailbox is the usual Amanda mailbox.

The distinctions between the two types of mailboxes physically are that:
• Guest mailboxes have numbers within a specific range, a range well 

outside the range of numbers used for the company or department’s 
telephone extension plan.

• Guest mailboxes use mailbox 996 as a template (while non-guest 
mailboxes use 997) as a template.

Usually guest mailboxes have no extension (and, usually, mailbox 996 does 
not process calls).In this case, the owners of guest mailboxes only call in for 
messages. For example, a lawyer might use them so that clients can call in 
for messages about their legal dealings. A sales representative who is never 
in the office, might have a guest mailbox so that clients can leave messages 
about their needs.

If you manage mailboxes for others, you have the power to create and delete 
those mailboxes or move them elsewhere in the mailbox tree.

To manage mailboxes:

1. From the Amanda Portal Station window, select the mailbox from the 
mailbox tree that is one of the following:

• Currently the parent of the mailbox to be managed

• Will be the parent of the new mailbox you are about to create
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NOTE: You can only create the selected mailbox’s children—
not grandchildren.

2. Click the Immediate Descendants icon: 
The Immediate Descendants dialog box opens.

If the dialog box is locked, you might not have permission to unlock it. 
See your Amanda administrator for details.

While this dialog box is locked, you can only create, delete, and move 
guest mailboxes. For more information about locks, see “Understanding 
Locks” on page 116.

Only the Amanda administrator, usually mailbox 999, can change the 
maximum number of mailboxes.

Creating a Mailbox
Creating a new mailbox by copying an existing one can save lots of time. 
The new mailbox gets the following information from the copied mailboxes:

• The settings in the existing mailbox’s Caller Options, User Options, 
and Method Information.

• All its notifications and schedules. 
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Notification records acquire new numbers for the new mailbox.

Schedules keep their original IDs.

• Its copy_to member list.

• Its privileges. However, no copied privilege can be enabled in the 
new mailbox if that same privilege is non-existent or disabled for the 
currently logged-into mailbox (the mailbox whose owner is creating 
the new mailbox). 

In other words, no creator of mailboxes can create a mailbox that has 
privileges that his or her own mailbox does not have.

Typically, regular mailboxes are copies of mailbox 997, and guest mailboxes 
are copies of mailbox 996. The mailboxes 997 and 996 are used as templates 
and not assigned to users.

To create a mailbox:

1. From the Immediate Descendants dialog box, click Create Mailbox....

The Create Mailbox dialog box opens.

2. Keep the Guest check box cleared so that you create a regular, non-guest 
mailbox.
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3. Type the first extension number in the From Mailbox text box.

4. Type the last extension number in the To Mailbox text box.

This creates all the mailboxes from the first to last extension numbers 
you provide.

If you don’t put a number in the To Mailbox text box, only one mailbox 
is created.

5. Do one of the following:

a. Keep the Copy From check box cleared to use your template 
(mailbox 997) to create the new mailbox.

b. Check the Copy From check box and type the number of the 
mailbox to be copied in the Copy Mailbox text box.

6. Click OK.

Deleting or Moving a Mailbox
Occasionally, you will need to delete or move a mailbox. For example as an 
employee leaves the company, you would delete that employee’s mailbox. 
However, if an employee switches departments, you might only move the 
mailbox to the other department manager’s responsibility. When a mailbox is 
moved, its settings and privileges remain as they were prior to the move.

To delete a mailbox:

1. From the Immediate Descendants dialog box, select the mailbox to be 
deleted.

2. Click Delete Mailbox.

3. Click Yes to confirm the deletion.

4. Click OK.
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To move a mailbox:

1. From the Immediate Descendants dialog box, select the mailbox to be 
moved.

2. Click Reparent....

The New Parent dialog box opens.

3. Select the new parent for this mailbox from the mailbox tree.

4. If this mailbox has descendants of its own that should also be moved, 
select the Move Descendants Of check box.

For example, if the company is being reorganized, an entire branch (or 
subtree) of mailboxes might need to be moved.

5. Click OK.
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Member Lists

Member lists are lists of Amanda mailboxes most commonly used as mailing 
lists. It is convenient to address messages only once to the entire group 
instead of individually to each person.

To manage member lists:

1. From the Amanda Portal Station window, select the mailbox from the 
mailbox tree.

2. Click the Member Lists icon: 
The Member Lists dialog box opens.
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This dialog box is never locked, so you can always create and update your 
member lists—with one exception. You must have the Message Copy To 
Privilege to create a copy_to list. The copy_to list for a mailbox is the list of 
Amanda users who will get copies of every message left in that mailbox.

Creating a Member List
There are three kinds of member lists that you can create:

• Mailing lists of Amanda users to use when you send messages.

You can have up to seven member lists named List 1 through List 7. The 
description you supply should indicate what the list consists of.

• Generic lists of Amanda users used for other purposes, perhaps for a 
plug-in application designed by your company or another vendor.
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• The “copy to” list which includes Amanda users who will get copies 
of every message left for your mailbox.

You can have only one such list. Its name is copy_to.

 It goes into effect as soon as it is created. For example, while a user is in 
training or on vacation, all his or her messages might be copied to a 
supervisor or co-worker. When the training period is over or the user 
comes back from vacation, the copy_to list should be deleted to stop the 
copying.

To create a member list:

1. From the Member Lists dialog box, click Create....

The Member List Name dialog box opens.

2. Select one of the types of member list by doing one of the following:

• Select the Mailing List option button, then select from List 1 to List 
7 from the Name drop-down list box.

• Select the Generic List option button, then give it a name using up 
to 16 characters.

• Select the Copy To Mailing List option button.

3. Click OK to return to the Member Lists dialog box.

The name of your new list should be selected in the List Name list box.
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4. In the Edit Description group box, click Voice.... to record a description 
of this list.

The Edit Multimedia Object dialog box opens. 

The audio description is to remind you what this list represents when 
you use the telephone user interface to send a message to a list of users.

Follow the steps for this dialog box in “Creating a Personal Greeting” on 
page 47. (The recorded description becomes a non-greeting MMO.)

5. Select a mailbox number from the All Mailboxes tree.

6. Click >>Add>> to add this mailbox to the Members list box.

NOTE: You cannot double-click the mailbox number in the 
tree to move it to the Members list box, but you can 
double-click a mailbox number in the Members list 
box to remove it from the list. 

7. Repeat steps 5 and 6 until the list is complete.

8. (Optional) Repeat steps 1 through 7 to create another list.

9. Click OK.

Editing a Member List
You can add or remove users from any of your member lists. However, you 
don’t have to update your lists when a mailbox is deleted from the Amanda 
system. Amanda automatically removes deleted mailboxes from member 
lists.



Chapter 10: Member Lists 69
To edit a member list:

1. From the Member Lists dialog box, select the name of the list from the 
List Name list box.

2. Do any or all of the following as often as necessary:

• Click Voice.... to re-record a description of this list.

The Edit Multimedia Object dialog box opens. Follow the steps for 
this dialog box in “Creating a Personal Greeting” on page 47.

• Click Display... to change the text description for this list.

The Edit Personal List Description dialog box opens.

- Type a new description in the Description text box then click 
OK.

• Add a member to the list by selecting a mailbox number from the 
All Mailboxes tree then clicking >>Add>>.

• Remove a member from the list by double-clicking a mailbox num-
ber in the Members list box. (You can also select the number and 
click <<Remove<<.)

3. Click OK.

Deleting a Member List
If a list becomes obsolete, you can delete it.

To delete a member list:

1. From the Member Lists dialog box, select the name of the list from the 
List Name list box.

2. Click Delete.

3. Click Yes to confirm the deletion.
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Notes for Administrators
Member/Mailing lists created from the Amanda administrator’s mailbox can 
be used from the telephone user interface. A logged-on user can use one of 
the administrator mailbox’s lists or one of his or her own lists. From Amanda 
Portal Station, any user can use any list.
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You manage messages from Amanda Portal Station’s Message Folders 
window or by using Amanda’s telephone user interface. This chapter 
explains how to use Amanda Portal Station for this purpose.

To manage message folders:

1. From the Amanda Portal Station window, select the mailbox from the 
mailbox tree.

2. Click the Message Folders icon: 
The Message Folders window display 10 folders, each of which can be 
used to store messages. Each folder has a tab, but not all of the tabs can 
be displayed simultaneously. use the scroll buttons to show additional 
tabs.
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At the bottom of the window are statistics for the selected folder. The 
statistics include the numbers of:

• Urgent messages

- Urgent New represents those that have not been reviewed

- Urgent Non-new represents those that have been reviewed

• Non-deleted messages (those not marked for deletion)

• Messages marked for deletion

• New messages (those that have not been listened to)

Each row in each folder represents a message that you have received. The 
following table explains the columns in the Message Folders window. The 
data is these column provide general information about each message.
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Message Columns in Each Folder
Column Description

Date Displays the date associated with the message. Depending on Aman-
da voice server options, it is either the date the message sent. This 
column sorts in ascending (oldest to newest) order.
Also in the date column are the status icons:

new message

new urgent message

old (heard or viewed) message

old urgent message

deleted message

Click the column header to sort your messages from oldest to most 
recent.

To Lists the mailboxes to which this message was sent. You mailbox number 
may be one of many. If the message was sent to a list, you see the list number, 
followed by an asterisk (*) and the mailbox that owns the list. For example, 
1*888 means Mailing List 1 for mailbox 888. The Amanda administrator 
(usually mailbox 999) often creates mailing lists that have systemwide 
utility, for example, a list of all users.
This column sorts in alphanumeric order.

From Displays one of the following:
The mailbox number of the Amanda user who is created the message. 
What information you see here depends on the workstation options 
you have set.
The word “Outside” if the call originated outside the Amanda sys-
tem.
This column sorts in alphanumeric order.
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Message Folders
The message folders (Folder 0 through Folder 9) can be renamed to suit your 
purposes. For example, Folder 0 could be renamed Inbox, and so forth. 

New messages are those that you haven’t played or, in the case of fax 
messages (and some other types of messages), those you haven’t viewed.

Forwarded By Displays the mailbox number of the Amanda user who forwarded this 
message to you.
This column sorts in alphanumeric order.

Subject Displays the subject of the message. If the subject is not text, it dis-
plays “Nontextual subject.”
This column sorts in ASCII order, with capital letters preceding low-
er case letters.

Attributes Displays additional message markings: Urgent, Private, Receipt
Urgent: Indicates that the caller who recorded the message marked 
it urgent. 
Private: Indicates that the caller who recorded the message marked 
it private (so it cannot be forwarded).
Receipt: Indicates that a message previously sent with a request for 
verification has now been reviewed.
This column sorts from highest to lowest: Urgent, Receipt, Private, 
none. When a message is both Private and Urgent, the word Urgent 
appears before the word Private in the attribute column.

Length Displays the lengths of the components in seconds and/or byte.
This column sorts in descending alphanumeric order.

Message Columns in Each Folder (Continued)
Column Description
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Amanda can put new messages in any folder. In fact, new messages that are 
urgent can go in a different folder than new messages that aren’t urgent. 
However, Folder 0 is the only folder that you can access when you log on to 
your mailbox over the telephone, so it makes the most sense to use Folder 0 
for incoming messages. By default, Amanda puts every incoming message 
in the Folder 0.

While there are new messages in any folder, your telephone’s message light 
(if you have one) remains on, so it is important that you move messages to 
other folders after you review them.

By default, the oldest message is at the top of each list and the newest 
message is at the bottom (sorted by date and time).

To change the name of the folder:

1. From the Message Folders window, select a folder tab.

2. Select Tools!Edit Folder Description... from the menu bar.

The Edit Folder Description dialog box opens.

3. Type a name for the folder in the Description text box using up to 16 
characters.

Being Notified about New Messages
You can be notified about new messages from your workstation. Amanda 
Portal Station can play a sound or display a message or icon.

To be notified about new messages:

1. From the Message Folders window’s menu bar, select Tools!Receive 
Options....
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The Receive Message Options dialog box opens.

2. Select any combination of the following methods of notification:

• Play a beep by checking the Play Sound check box.

• Display the following message by selecting the Display A Notifica-
tion Message check box.

• Display the new message  icon on the taskbar (in the system 
tray) selecting the Display Icon On Taskbar check box.

Playing or Viewing a Message
As you receive new messages, your message light goes on and your 
workstation prompts you (unless you have new message notification turned 
off). You, of course, will want to review them.
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To play or view a message:

1. From the Message Folders window, select the correct folder.

2. Do one of the following:

• Double-click the message.

• Click Play/Review at the bottom of the Message Folders window.

If the message has only one component, Amanda Portal Station plays it 
or displays it. If the message has more than one component, Amanda 
Portal Station plays or displays first component, then displays the Mes-
sage dialog box so that you can review other components as well.

See “Reviewing Message Properties” on page 91 for more information 
about the Message dialog box.

Sorting Messages
You can sort messages within a folder based on the contents of any column. 
You can also sort them by arranging them in any of your 10 message folders.

To sort messages within a folder:

• Click the column header.

Each header has its own sort order, explained in the table named “Mes-
sage Columns in Each Folder” on page 73.

To move a message to another folder:

• Do one of the following:

- Drag the message from its location in one folder to the tab for the 
other folder.

- Refile the message using the Edit menu’s Refile Message... com-
mand.
a. Select the message.
b. Select Edit!Refile Message... from the menu bar.
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The Refile dialog box lists all the other folders.

c. Select the folder that will store this message.
d. Click OK.

NOTE: You cannot move a message that is currently marked for 
deletion.

Deleting a Message
You mark unwanted message for deletion. However, they are not deleted 
until you log off the workstation or until a purge takes place.

Once a message is marked for deletion, the only operations you can perform 
on it are purge and undelete.

You can control when message are permanently deleted or purged and when 
the purge takes place.

To control when messages are deleted:

1. From the Message Folders window’s menu bar, select Tools!Receive 
Options....
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The Receive Message Options dialog box opens.

2. Do one or both of the following:

• To delete messages as part of the logoff operation, select the Purge 
Deleted Messages On Logoff check box.

When this check box is cleared, the messages you have marked for 
deletion can be deleted only manually by selecting Edit!Purge 
Deleted Messages from the menu bar. 

• To delete messages that have been in your mailbox for several days, 
type a number of days in the Purge After text box.

This deletes old messages but never messages that have not been 
listened to. It doesn’t matter if these messages have been marked 
for deletion or not.

To mark messages for deletion:

1. Select the message to be deleted.

2. Select Edit!Delete from the menu bar.

Until the messages are physically removed from the server, you can res-
cue them.

While a message is marked for deletion, it cannot be forwarded, replied 
to, or reviewed.
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To “undelete” a messages that is marked for deletion:

1. Select the message that is marked for deletion.

2. Select Edit!Undelete from the menu bar.

To delete messages marked for deletion in all folders:

1. Select Edit!Purge Deleted Messages from the menu bar.

A message asks:

2. Click Yes to confirm.

Depending on your message options, these messages may also be 
deleted automatically as you log off.

Composing and Sending a Message
You can record a new message or a component for a new message using your 
telephone or your workstation. You can also add a component from an 
existing message or import an existing .WAV file as a component. Your 
message can contain up to 30 components.

To compose and send a message from your workstation:

1. From the Message Folders window’s menu bar, click 
Sending!Compose New….

The Message dialog box automatically displays the current date and 
time in the Date text box.
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2. Click To... to pick other Amanda users to send your message to.
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The Send To dialog box opens.

You can expand the tree in the User Tree box. For example, expanding a 
mailbox number shows the mailboxes child mailboxes and its mailing 
lists.

3. Select a mailbox number or mailing list from the tree.

4. Click >>Add>> to add it to the To list box.

TIPS: You can check what mailbox numbers are in a mailing 
list before you add that mailing list to the To list box. 
Select the mailing list from the tree. Then click Show 
List>> to display the numbers in the Mailing List box.

Double-clicking a item in the tree does not add it to the 
To list box, but double-clicking an item that is already 
in the To list box does remove it from the list box. 
Trees do not operate the same way as lists.

Goto allows you to select an item in the To list box and 
immediately select that same item from the tree. This 
makes finding mailing lists and mailbox numbers in a 
tree with many branches easy. For example, you might 
want to reassure yourself that you selected the correct 
mailing list by reviewing its contents. This can be very 
useful when reviewing a received message.
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5. Repeat steps 3 and 4 until you have listed all the recipients for this mes-
sage.

6. Click OK to return to the Message dialog box.

7. (Optional) Type a subject for your message in the Subject text box.

8. (Optional) You can file a copy of the message in one of your folders by 
selecting that folder from the FCC drop-down list box.

For example, Folder 4 may have been renamed Sent Messages.

9. (Optional) Click Add... to create, import, or otherwise locate a file con-
taining your message or a message component.

The Edit Multimedia Object dialog box opens.

• Follow the steps in one of the procedures below. They explain how 
to record a message component, import a file as a message compo-
nent (for example, a .WAV file), or use a cached multimedia object 
(MMO) as a message component. A cached MMO is a file you 
have reviewed recently, such as a message or a greeting, so it is still 
in your cache. The MMO you create will appear in the Components 
List box.
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To record a message component from your workstation:
a. From the Source group box, select the Create New option 

button.
b. Select an audio format from the Format/Conversion group 

box by doing one of the following:

• Select the Wave To <Format> option button.
This is the usual format for message components.

• Select the Advanced Formats check box; then select one of 
the audio formats from its list box.

c. Click OK.
The Sound Recorder (or a similar application) starts.

d. Record the message, save the file, then exit the application.
Amanda asks if you want to apply these changes to your 
greeting.

e. Click Yes to return to the Edit Multimedia Object dialog 
box.

f. Click OK to return to the Message dialog box.

To import a message component:
a. From the Source group box, select the Import option but-

ton.
The Windows standard Open dialog box opens.

b. Select an audio file, usually a .WAV file to import.
c. Click OK to return to the Edit Multimedia Object dialog 

box.
d. Click OK to return to the Message dialog box.

To use a cached multimedia object (MMO) as a message 
component:
a. From the Source group box, select the Cached MMOs op-

tion button.
The Component List dialog box lists the MMOs in the 
cache. Objects in the cache are files that you have created 
or listened to recently. For example, if you want to “bor-
row” a sound component from another message, play that 
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component, then locate it in the cache.

b. Select an object.
c. (Optional) Click Review to listen to or display the object.
d. Click OK to return to the Edit Multimedia Object dialog 

box.
e. Click OK to return to the Message dialog box.

10. (Optional) You can select a time in the future for this message to be 
sent:
a. Click Future Delivery....

The Time for Future Delivery dialog box displays a calendar.

b. Select a date and time.
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TIP: Use the Set For Current Time check box if you 
change your mind about sending this message 
later.

c. Click OK.

11. (Optional) Similarly, you can set an expiration date for a message. Then 
if the recipient has not reviewed the message before that time, it is auto-
matically deleted from that recipients message folder.
a. Click Expire....

The Expire Message dialog box displays a calendar.

b. Select the Set Message To Expire check box.
c. Select a date and time.

TIP: Clear the Set Message To Expire check box if you 
change your mind about using an expiration date.

d. (Optional) Select the Absolute check box to automatically de-
lete the message at the specified date and time—even if the user 
has heard the message.

e. Click OK.

12. (Optional) You can make this message urgent by selecting the Urgent 
check box.
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Urgent messages are usually brought to the recipients quickly. Over the 
telephone, they are often put at the beginning of the message list. In the 
Message Folders window, the urgent  icon precedes the message.

13. (Optional) You can make this message private by selecting the Private 
check box.

Private messages cannot be forwarded.

14. (Optional) You can request that read-receipt messages be sent to you 
when recipients review the message by selecting the Read Receipt 
check box.

15. Click Send to send this message.

TIPS: There are more things you can do to this message before 
you send it:

• Create an audio or multimedia subject by clicking Play Sub-
jects... and performing on of the procedures in step 10.

• Review a component by selecting it from the Component List 
box then clicking Play/View....

• Delete a component by selecting it from the Component List 
box then clicking Remove.

• Rearrange components using Move Up and Move Down.

Forwarding a Message
You can forward a message exactly as it is, or you can forward it with 
additional components, called prefixes. For example, you might want to 
explain to the recipient why you are forwarding the message.

To forward a message:

1. From the Message Folders window, select the message to be forwarded.

Do not select a message that has been marked for deletion.
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2. Click Sending!Forward Message... from the menu bar.

The Message dialog box automatically displays the current date and 
time in the Date text box, puts your mailbox number in the Forwarded 
From text box and the mailbox number of the user who originally cre-
ated the message in the From text box. It also adds “FW:” to a subject (if 
the subject is text) to indicate that the message is being forwarded.

3. Click To... to pick other Amanda users to forward your message to.
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The Send To dialog box opens.

4. Select a mailbox number or mailing list from the tree.

5. Click >>Add>> to add it to the To list box.

6. Repeat steps 4 and 5 until you have listed all the recipients for this mes-
sage.

7. Click OK to return to the Message dialog box.

8. (Optional) You can file a copy of the message in one of your folders by 
selecting that folder from the FCC drop-down list box.

For example, Folder 4 may have been renamed Sent Messages.

9. (Optional) Click Add... to create, import, or otherwise locate a file con-
taining a prefix for this message.

The Edit Multimedia Object dialog box opens.
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Any components you add to the message appear at the beginning of the 
message. You can rearrange the components you add (so long as the pre-
cede the original components of the message), but you cannot rearrange 
the components from the original message.

See “Composing and Sending a Message” on page 80 for more informa-
tion about using this dialog box and setting other message options in the 
Message dialog box. Follow steps 10 through 15.

10. Click Send to send this message.

Replying to a Message
When you reply to a message sent to you by someone on the Amanda 
system, Amanda Portal Station automatically addresses your reply to that 
person. 

To reply to a message:

1. From the Message Folders window, select the message to be replied to.

Do not select a message that has been marked for deletion.

2. Do one of the following:

• Click Sending!Reply Message... from the menu bar to reply to 
the sender of the message.

• Click Sending!Reply All... from the menu bar to reply to the 
sender and to anyone else who received this message.

The Message dialog box automatically displays the current date and 
time in the Date text box. It adds “RE:” to a subject (if the subject is 
text) to indicate that the message is being replied to. It also addresses the 
reply to the sender and, if you selected Reply All..., the other recipients 
of the original message.

3. Click Add... to create, import, or otherwise locate a file containing your 
message.

The Edit Multimedia Object dialog box opens.
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See “Composing and Sending a Message” on page 80 for more informa-
tion about using this dialog box and setting other message options in the 
Message dialog box. Follow steps 10 through 15.

4. Click Send to send this message.

Reviewing Message Properties
Occasionally, you might want to check the settings for a message that resides 
in one of your message folders. For example, you can mark a message as 
urgent as a reminder to yourself—even though the message wasn’t sent as an 
urgent message.

To review message properties:

1. From the Message Folders window, select the message to be reviewed.

Do not select a message that has been marked for deletion.

2. Do one of the following:

• Click Sending!Message Properties... from the menu bar.

• Right-click the message.

The Message dialog box displays details about the message.
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TIPS: The Caller ID text box can be copied for other uses.

You can use the Urgent check box to change this message’s 
status from urgent to non-urgent.

You can change the subject to be more informative. For ex-
ample, if you plan to store this message for a long time, its 
current subject might not help you to identify it.

You can mark this message for deletion (or “undelete” it) 
by selecting or clearing the Delete Message check box.

You can change which folder stores this message using the 
Refile Message drop-down list box.

You can review when this message was sent, to whom, 
from whom, review its subject and components, total 
length, and so on.
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Moving All Messages to Another Mailbox
Sometimes you need to move all the messages from one mailbox to another. 
For example, if Amanda is set up at a hotel or motel, and a guest moves from 
one room to another, her messages can be moved to her new room’s mailbox.

To move all the messages in one mailbox to another:

1. From the Message Folders window, select Tools!Move All Messages 
to Mailbox....

The Relocate Messages dialog box opens.

2. Select the recipient mailbox.

TIP: Double-click mailbox numbers to expand branches in the 
tree.
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Allowing and Limiting Time for Messages
Some mailboxes never allow messages because they are not used by users 
who are expecting messages. For example, the administrator mailbox 
(usually mailbox 999) is used for administrative purposes only. The Amanda 
administrator has a personal mailbox as well. 

Normally, the ability to allow messages is determined by the administrator or 
a supervisor. For the owner of the mailbox, Allow Messages is usually 
locked.

The maximum length for messages is always locked for the owner of a 
mailbox. You can set a message time limit only for mailboxes that are 
descendants of your mail box.

To allow messages and/or set a maximum length for individual 
messages:

1. From the Message Folders window’s menu bar, select Tools!Receive 
Options....

The Receive Message Options dialog box opens.

2. Select or clear the Allow Messages check box.
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3. Set a message’s maximum length by doing one of the following:

• Select the Infinite check box for unlimited message lengths.

• Clear the Infinite check box then type a number of seconds in the 
Maximum Length text box.

4. Click OK.

Using Windows Applications
Amanda Portal Station uses the Windows applications that are associated 
with opening .TIF, .HTM, and .TXT files. For example, if Notepad is the 
application associated with .TXT files, Amanda Portal Station displays text 
in Notepad.

Amanda Portal Station also uses Windows applications to both record and 
play messages. The applications designated on your computer for these 
purposes may be different than those used on other computers. How to 
identify the applications for playing and recording is explained in the next 
two sections.

Identifying the Application that Records Messages
Amanda Portal Station starts the application your workstation has set for 
opening .WAV files. This is usually Sound Recorder (sndrec32.exe), which 
is stored in the Windows folder (usually C:\WINDOWS).

To check this setting:

1. Open the My Computer window.

2. On the View menu, click Options….

The Options dialog box appears.

3. Click the File Types tab.

4. Find “WAVE Sound” or a similar name in the Registered File Types list 
box. Then click Edit….
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The Edit File Type dialog box appears.

5. Select Open from the Actions list box. Then click Edit….

The Editing Action For Type dialog box appears.

6. Notice what application appears in the Application Used To Perform 
Action text box.

Identifying the Application that Plays Messages
When you listen to a voice message, Amanda Portal Station starts the 
application your workstation has set for playing .WAV files. This is usually 
Sound Recorder (sndrec32.exe), but you might prefer Media Player 
(mplayer.exe). Both are stored in the Windows folder (usually 
C:\WINDOWS). 

To check this setting:

1. Open the My Computer window.

2. On the View menu, click Options….

The Options dialog box appears.

3. Click the File Types tab.

4. Find “WAVE Sound” or a similar name in the Registered File Types list 
box. Then click Edit….

The Edit File Type dialog box appears.

5. Select Play from the Actions list box. Then click Edit….

The Editing Action For Type dialog box appears.

6. Notice what application appears in the Application Used To Perform 
Action text box.
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Amanda Portal Station usually uses notification records to notify users that 
they have messages. The records tell Amanda to:
• Turn message lights on and off 
• Page users using their pager numbers
• Call users at their homes, off-site locations, or other extensions
• Use an office paging system to locate users
• Notify a user when some other action occurs on the server

To manage notifications:

1. From the Amanda Portal Station window, select a mailbox from the 
mailbox tree.

2. Click the Notification icon: 
The Notification dialog box opens.
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Only when this dialog box is unlocked can you create or edit notification 
records.

If it is locked, you might not have permission to unlock it. See your 
Amanda administrator for details. For more information about locks, see 
“Understanding Locks” on page 128.

Managing Notification Records and 
Templates

Notification records are created:
• When the mailbox is created (by copying the notification records 

that already exist in the mailbox on which the new mailbox is 
based—although the records are given new identification numbers)

• By adding them individually to existing mailboxes
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Each user can have any number of notification records.

Managing notification records includes:
• Creating and modifying notification templates and records. 
• Making the notification records needed by most or all users part of 

the mailbox template (by default mailbox 997). 

For example, if the records that turn message lights on and off are in the 
template, you don’t have to create those records for each mailbox that 
requires them.

• Testing notification templates and records by making calls to users 
and verifying that the expected notification takes place.

If users’ telephones have message lights, you need notification records that 
turn those lights on and off. You program a normal notification record to turn 
the light on and a pickup notification record to turn the light off.

Users with pagers can be notified using normal or urgent notification 
records. 

A normal notification record works for both urgent and non-urgent 
messages.

Creating a Notification Template or Guard 
Method

Both notification templates and guard methods are methods. They are 
created in the same way as other methods but some may require information 
about the switching system connected to Amanda. For example, to turn the 
telephone’s message light on or off, you need to know what message to send 
to the switching system.

The notification method dictates what actions are taken when a new message 
arrives. The guard method is executed when some other user-defined 
requirement is met. For example, if a user is not responding to notification, 
the guard method might take an alternative action when five new messages 
have accumulated. It must return a value of true or false. 
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To create a new notification template or guard method:

1. From the Notification dialog box, click the Select... for templates or the 
Select... for guard methods.

The Existing Method List dialog box opens.

2. Follow the steps for creating methods in “Creating a Method” on 
page 100.

Creating a Notification Record
You can create notification records for your mailbox (if you have the correct 
privileges) and for the descendants of your mailbox.

The notification records are uniquely numbered throughout the system 
starting with 1. Mailboxes acquire notification records from the mailbox that 
was copied to create them—although new numbers are attached to each 
record for the new mailbox. You can create additional notification records 
for a mailbox later, but each has a new number.

If you see a number in the Notify drop-down list box, an existing notification 
record appears in the dialog box.

If you already have several notification records, one might be very similar to 
the one you are creating. Starting with it can save you time.

To create a new notification record:

1. (Optional) Select a number from the Notify drop-down list box.

2. Click Create to immediately start a new notification record with the cur-
rent record’s settings.

If you don’t click Create at this point, you could accidentally edit an 
existing record (by clicking OK or Apply).

3. (Optional.) Click Clear to reset the entire dialog box to its default set-
tings—unless you want to use the existing settings.
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4. Select a template for this notification record:
a. From the Template group box, click Select.... 

The Existing Method List dialog box opens.
b. Select a template from the Method Name list box.
c. Click OK to return to the Notification dialog box.

NOTE: The notification method dictates what actions are taken 
when a new message arrives.

5. (Optional.) Select a guard method for this notification record:
a. From the Guard Method group box, click Select.... 

The Existing Method List dialog box opens.
b. Select a guard method from the Name list box.
c. Click OK to return to the Notification dialog box.

NOTE: The guard method must return a value of true or false. For 
example, if a user is not responding to notification, the 
guard method might take an alternative action when five 
messages have accumulated.

6. Use the Maximum Executions group box to indicate how many success-
ful and/or how many unsuccessful notifications must be performed 
before the notification can be stopped.
a. Select the Successful tab.
b. Do one of the following:

• Type the number of times to successfully notify the owner of 
this mailbox before stopping.
The default is 1.

• Select the Infinite check box to continue notification indefi-
nitely.
If the notification is about new messages, the notification 
stops when the user picks up the messages.

c. Select the Failure tab.
d. Do one of the following:

• Type the number of notification failures that must occur before 
giving up.
The default is 10.
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• Select the Infinite check box to continue notification indefi-
nitely, regardless of the number of failures.
If the notification is about new messages, the notification 
stops when the user picks up the messages.

7. Select a type of notification from the Type drop-down list box.

Normal Indicates that the user has new or urgent messages. 
Normal notification templates turn on message lights, 
page users, call them at home, and so forth. (Normal 
notification records handle both urgent and non-urgent 
messages.)

Pickup Indicates that the user has picked up (listened to) all 
the new messages. It usually turns off a message light.

Urgent Indicates that the user has urgent messages. Urgent 
notification templates usually page users or call them 
at their current location.

8. If the template method requires a variable, type a pager number, tele-
phone number, or other variable (whichever is appropriate) in the Vari-
able text box.

9. Indicate the time of day the notification record can be executed. For 
example, perhaps the user should only be notified during working hours, 
such as from 8 A.M. to 5 P.M. (8:00 to 17:00 on the 24-hour clock). Do 
the following:
a. Select the From tab.
b. Type a starting time in the spin box (use the 24-hour clock).
c. Select the To tab.
d. Type an ending time in the spin box (use the 24-hour clock).
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10. Do one or both of the following:

• Select a group of days simultaneously by selecting the Everyday, 
Weekdays, or Weekend option button.

• Indicate what days the notification record can be executed by 
selecting the appropriate days’ check boxes from the Execute On 
Days... group box.

11. Indicate when and how often the notification record should be executed 
after the reason for notification (for example, the arrival of a message) 
occurs.

(Amanda retries Normal notification records until either the user listens 
to the message or the maximum number of retries has occurred. 
Amanda stops executing Urgent and Pickup records only when the max-
imum number of retries has occurred.)
a. In the Continue Every spin box, type the number of minutes be-

tween executions of the notification record.
b. In the After spin box, type the number of minutes between when 

the reason for notification occurs and when the notification 
record is executed.

12. (Optional) Select the Protected check box to prevent the owner of the 
mailbox from changing this notification record.

13. After setting all the options on the dialog box, you will click Apply to 
update this new notification record with those new settings.

Deleting a Notification Record
You can delete notification records.

To delete a notification record:

1. From the Amanda Portal Station window, select the mailbox from the 
mailbox tree.

2. Click the Notification icon: 
The Notification dialog box opens.
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3. Select the record to be deleted from the Notify drop-down list box.

4. Click Delete.

This deletes the record from this mailbox only.

Changing Notification Telephone Numbers
If a user changes his pager number or another telephone number used in a 
notification record, you need to change the contents of the Variable field for 
that record.

You can change the number for the user or the user, with the correct 
privileges, can change the Variable text box in the Notification dialog box.

To change a notification record’s Variable field:

1. From the Notification dialog box, type the number of the notification 
record in the Notify drop-down list box.

2. Type the new number in the Variable text box.

5. Click Apply or OK.

Emergency Lists
Amanda can use an emergency list to notify a group of people about a new 
message. Amanda notifies the first person of the new message first, then 
after a time, notifies the second, and so forth until someone listens to the 
message. You define the initial time to wait before starting the notification, 
and the time interval between notifications. 

In the following example, you create three notification records for one 
mailbox. Each record contains a different telephone number to call (one for 
each of the three people who are to be notified). 
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The records are configured this way:

This configuration causes Amanda to execute record 1 immediately and at 
five-minute intervals. After 15 minutes, if the message is not picked up, 
Amanda starts using record 2 every five minutes (in conjunction with record 
1). After 30 minutes, Amanda executes record 3. All three records continue 
every 5 minutes until the message is picked up.

For Max Times, this example uses 0 so that notification only stops when 
someone receives the message. Under normal circumstances, The Amanda 
Company does not recommend using 0.

After Waiting Retry Every For

Record 1 0 5 0

Record 2 15 5 0

Record 3 30 5 0
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Chapter 13:
Privileges

You can perform operations on a mailbox if either of the following are true:
• No privilege or lock covers the operation (as when setting incoming 

call options and some logon options). 
• The privilege to perform that operation is assigned to and enabled 

for the mailbox you are logged onto

Initially the Amanda administrator’s mailbox (usually mailbox 999) has all 
the privileges enabled. The Amanda administrator can delegate them to a 
child mailbox, whose owner can, in turn, delegate any privileges that that 
mailbox has to its child mailboxes. A mailbox can have any privilege that 
was given to it by the owner of any ancestor mailbox with that privilege.

NOTE: The Amanda administrator can enable/disable privileges 
for mailbox 999. All other mailboxes can enable/disable 
privileges only for its descendants.

You create a mailbox as a copy of another mailbox, usually 997 for non-
guest mailboxes—that is, mailboxes with extensions—or 996 for guest 
mailboxes. Initially, the new mailbox usually has the same states (enabled or 
disabled) for these privileges as the mailbox that was copied. The exception 
to this is that the new mailbox cannot have a privilege enabled if its parent 
mailbox has that privilege disabled.
For example, suppose that mailbox 999 is the root of the mailbox tree and 
that it has child mailboxes 777 and 888. Suppose that the owner of mailbox 
999 enables the privilege to create mailboxes for both mailboxes 777 and 
888. Suppose the privilege to change the Do Not Disturb setting is enabled 
for mailbox 777 and disabled for mailbox 888. 
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The owner of mailbox 777 can create mailboxes that can change their Do 
Not Disturb settings, but the owner of mailbox 888 cannot—even if the 
mailbox being copied (for example, mailbox 997) has Do Not Disturb 
enabled. However, the owner of mailbox 999, the ancestor of mailbox 888, 
could enable the Do Not Disturb privilege for descendants of mailbox 888.
If a descendant of mailbox 777 is moved so that it is a descendant of 888, 
that descendant does not lose or gain any privileges based on its new parent.

The owner of a mailbox can revoke any privileges for any of its descendants 
it has those privileges enabled. For example, because the Do Not Disturb 
privilege is enabled for mailbox 777, the owner of mailbox 777 can revoke 
the Do Not Disturb privilege for a descendant, for example, mailbox 110. 
The owner of mailbox 777 can revoke the privilege either by:
• Disabling the privilege for mailbox 110
• Locking the Do Not Disturb feature (in the Incoming Call Options 

dialog box) for mailbox 110

The above two operations are equivalent. Disabling a privilege sets the 
corresponding lock. Locking the feature changes the privilege to disabled.

The owner of mailbox 110 cannot control this feature (until it is enabled or 
unlocked by the owner of an ancestor mailbox with the ability to do so).
For more information about locking features, see “Understanding Locks” on 
page 116.

To view mailbox privileges:

1. From the Amanda Portal Station window, select a mailbox from the 
mailbox tree.

2. Click the Privileges icon: 
The Privileges dialog box displays this mailbox’s privileges.
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This dialog box can be extended horizontally to show all its columns.
The columns are:
Privilege The name of the privilege.
Logon State You may be logged on as a different mailbox than the 

one whose privileges you are reviewing. This column 
indicates whether this privilege is enabled or disabled 
for someone logging on to this mailbox right now. If 
you are logged on to this mailbox, these are your privi-
leges.

Logon Value This field indicates the value of this privilege for some-
one logging on to this mailbox right now. Values are 
usually 1 for an enabled privilege and nothing for a dis-
abled privilege, but your system may have some addi-
tional settings for special privileges written for your 
site.

Server State This field indicates whether this privilege is enabled or 
disabled for the mailbox you are reviewing. It is called 
Server State because the server keeps track of privileges 
for each box and this column indicates what the server 
has registered as the state of a given privilege for this 
mailbox.

Server Value This field indicates the value (on the server) of this priv-
ilege for the mailbox you are reviewing. 
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User State This field is empty unless you decide to change this 
privilege’s state for the mailbox you are reviewing. It is 
called User State because, when you click Toggle Lock 
to change the status, the server is not immediately aware 
of the change. For example suppose the mailbox you are 
reviewing cannot create mailboxes. You select the Cre-
ate Non-guest Privilege and click Toggle Lock. The 
User State becomes enabled, but the Server State 
remains disabled until the message about the change of 
state reaches the server. Then the server state field 
becomes enabled and the User State field becomes 
empty once more. The server finds out about the change 
when you click OK.

User Value When you select a privilege and click Edit Value..., this 
field immediately reflects the new value for the mailbox 
you are reviewing. When the message about the value 
change reaches the server, the Server Value field is 
updated, and the User Value field becomes blank once 
more. 

The following table describes the privileges that come with Amanda. 
Your Amanda administrator may have added new privileges that are not 
in the table.

Privileges
Option Privilege to...

Allow Message Privilege Change the allow messages setting.
Another way to enable/disable this privilege: Double-click the 
Message Folder icon. Select Tools⇒ Receive Options... from the 
menu bar. Use the Locked button in the Receive Message Options di-
alog box.

Announcement Mailbox 
Privilege

Manipulate announcements in the announcement mailbox (usually 
993). These are general announcements.

Announcement Privilege Manipulate announcements for the mailbox you own.
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Auto Schedule Privilege Change the auto schedules.
Another way to enable/disable this privilege: Double-click the Auto 
Scheduler icon and use the Locked button.

Call Screening Privilege Change the call screening setting.
Another way to enable/disable this privilege: Double-click the In-
coming Call Options icon and use the Locked button in the Call 
Screening group box.

Configuration Privilege Change system configuration.

Create Mailbox Privilege Create mailboxes—other than guest mailboxes. 
It is not enough to give the mailbox this privilege and/or enabling it. 
You must also:
• Specify a positive number of mailboxes that can be created 

(Double-clicking the Immediate Descendants icon and type 
a number in the Maximum Number Of Mailboxes text box).

Another way to enable/disable this privilege: Use the Non-guest 
Lock button in the Immediate Descendants dialog box.

Create Trie Mapping 
Privilege

Create or delete a mailbox mapping (for example, the public directory is a 
mapping). 
Another way to enable/disable this privilege: Double-click the General 
Information icon and use the Public Directory’s Entries group box’s Locked 
button.

Disconnect Mailbox 
Privilege

Disconnect a user from the system. 
Another way to enable/disable this privilege: Double-click the 
Administrative Monitor icon and use the Locked button at the bottom 
of the dialog box or the Locked button on the Users tab.

Do Not Disturb Privilege Change the do not disturb setting.
Another way to enable/disable this privilege: Double-click the In-
coming Call Options icon and use the Locked button in the Do Not 
Disturb group box.

Privileges (Continued)
Option Privilege to...
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Edit Trie Mapping Privilege Edit text associated with a mapping (for example, because the public direc-
tory is a mapping, this mailbox’s owner can edit the names and pronuncia-
tions for the public directory). 
Another way to enable/disable this privilege: Double-click the General 
Information icon and use the Entries group box’s Locked button.

Extension Privilege Change the extension and server setting.
Another way to enable/disable this privilege: Double-click the General 
Information icon and use the group box’s Locked button.

Grammar Privilege Set the speech recognition grammar. 

Greeting Privilege Manage greetings.
Another way to enable/disable this privilege: Double-click the Greet-
ings icon and use the dialog box’s Locked button.

Message Copy To Privilege  Change the copy to listing.

Message Relocation 
Privilege

Move all messages from one mailbox to another. 
This privilege controls the Tools⇒ Move All Messages to Mail-
box... menu command in the Message Folders window.

Method Database Privilege Change the methods of the mailbox.
Another way to enable/disable this privilege: Double-click the Method 
Information icon and use the dialog box’s Locked button.) 
This privilege does not affect the Transfer Method on the Incoming Call Op-
tions dialog box.

Method Edit Privilege Change the persistent methods.
Another way to enable/disable this privilege:  Use the Locked button in 
the Persistent Method List dialog box. There are several ways to access this 
dialog box.

Monitor Privilege Monitor the server system. 
Another way to enable/disable this privilege: Double-click the Ad-
ministrative Monitor icon and use the Locked button at the bottom of 
the dialog box. This effectively disables the Reset Port Privilege and 
the Disconnect Mailbox Privilege as well.

Privileges (Continued)
Option Privilege to...
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Adding Privileges
You can add privileges to a mailbox.

To add a privilege to a mailbox:

1. From the Privileges dialog box, click Add....

2. The Add Privileges dialog box lists all the parent privileges that the cur-
rent mailbox does not yet have.

Notify Record Privilege Change the notify records.
Another way to enable/disable this privilege: Double-click the Notifi-
cation icon and use the dialog box’s Locked button.

Notify Template Privilege Change the notify templates.

Reset Port Privilege Reset a port. 
Another way to enable/disable this privilege: Double-click the 
Administrative Monitor icon and use either the Locked button at the 
bottom of the dialog box or the Locked button on the Ports tab.)

Reset Statistics Privilege Reset the statistics of a mailbox. 
Another way to enable/disable this privilege: Double-click the Statistics 
icon and use the dialog box’s Locked button.

Route Privilege Change the routing of calls.

Shutdown Privilege Shutdown the server.

Privileges (Continued)
Option Privilege to...
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3. Select a privilege then click OK.

4. After you add a privilege, check that its state, enabled or disabled is cor-
rect for this mailbox.

NOTE: If you are logged onto the Amanda administrator mailbox, 
you see the following dialog box, which allows you to add 
new privileges to the system.

Type the name of the privilege and its value. By default, the 
new privilege is enabled.

You cannot add privileges to your own mailbox unless your 
mailbox is the administrator mailbox.
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Enabling and Disabling Privileges
You can turn a privilege on or off by changing its state. The server does not 
become aware of the change until you click OK.

To enable or disable a privilege that a mailbox currently has:

1. From the Privileges dialog box, select a privilege.

2. Click Toggle Lock.

If the Server State is disabled, the User State becomes enabled.

If the Server State is enabled, the User State becomes disabled.

Clicking Toggle Lock a second time changes the User State back to the 
Server State.

As soon as the Amanda server receives the message about the change in 
state for this privilege, the Server State field is updated and the User 
State field becomes blank.

Changing Privilege Values
You can change a privilege’s value (if it has one) by editing that value. The 
server does not become aware of the change immediately.

To change the value of a privilege:

1. From the Privileges dialog box, select an enabled privilege.

You cannot change the value of a disabled privilege (because it has no 
value).

2. Click Edit Value....

A dialog box opens, displaying the name of the selected privilege as its 
title.

3. Type a new value in the Value text box.
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4. Click OK to return to the Privileges dialog box.

The new value appears in the User Value field.

As soon as the Amanda server receives the message about the change in 
state for this privilege, the Server Value field is updated and the User 
Value field becomes blank.

Understanding Locks
The owners of mailboxes that are ancestors of other users’ mailboxes (that is, 
the owners of mailboxes higher up the branch of the tree to which the users’ 
mailboxes have been assigned) can lock portions of the user interface.

For example, if mailbox 888 is an ancestor of mailbox 116 and mailbox 888 
has a particular privilege enabled, the owner of mailbox 888 can enable that 
privilege if it is currently disabled.

The owner of mailbox 888 can revoke the privilege for mailbox 116 later 
either by:
• Disabling it for mailbox 116
• Locking Do Not Disturb (in the Incoming Call Options dialog box) 

for mailbox 116

The owner of mailbox 116 cannot control this feature (until it is enabled or 
unlocked by the owner of an ancestor mailbox with the ability to do so).

The difference between disabling the privilege and locking the feature are as 
follows:
• Disabling the privilege affects anyone who accesses the mailbox (al-

though the owners of ancestor mailboxes can often re-enable the 
privilege).

• Locking the feature affects only the owner of the mailbox; for exam-
ple, the owner of the ancestor mailbox that performs the locking op-
eration is not affected.

There are several lock states as shown in the following table. The states 
simultaneously indicate what both the server and logged-on user believe the 
lock state to be.
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Lock States

State Description

Locked The server knows that the feature or set of features controlled by this lock are 
locked. So does the logged-on user.

User unLock When the user clicks the Locked button, it changes to User unLock.
When the user clicks OK to exit the dialog box, the server is notified. If the 
user reopens the dialog box, the button is unLocked.

unLocked The server knows that the feature or set of features controlled by this lock are 
unlocked. So does the logged-on user.

User Lock When a user clicks the unLocked button, it changes to User Lock.
When the user clicks OK to exit the dialog box, the server is notified. If the 
user reopens the dialog box, the button is Locked.

Both Locked While the logged-on user thinks the lock is unlocked, the server state changes 
to locked. (For example, the owner of this mailbox’s parent may have locked 
the feature.) When the user clicks unLocked, the button becomes Both 
Locked. 
When the user clicks OK to exit the dialog box, the server is notified. If the 
user reopens the dialog box, the button changes to Locked.

Back to unLocked If the user clicks Both Locked, the button becomes Back to unLocked.
When the user clicks OK to exit the dialog box, the server is notified. If the 
user reopens the dialog box, the button changes to unLocked.

Both unLocked While the logged-on user thinks the lock is locked, the server state changes 
to unlocked. For example, the owner of this mailbox’s parent may have un-
locked the feature.
When the user clicks Locked, the button becomes Both unLocked. 
When the user clicks OK to exit the dialog box, the server is notified. If the 
user reopens the dialog box, the button changes to unLocked.

Back to Locked If the user clicks Both unLocked, the button becomes Back to Locked.
When the user clicks OK to exit the dialog box, the server is notified. If the 
user reopens the dialog box, the button changes to Locked.



118 Using Amanda Portal Station



Chapter 14:
Using Phonics

Often you will have to spell names and other words phonetically so that 
Amanda will pronounce them correctly and understand a caller’s 
pronunciation or mispronunciation of them. To change the pronunciation of 
existing directory names, you use the Phonics icon.

To access Phonics:
• From the Amanda Portal Station window, click the Phonics icon:

The Phonics dialog box displays Directory Names and their phonetic 
spellings.
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To change the pronunciation of a name:

1. Select the name or word whose pronunciation needs to be changed from 
the Text list box.

2. Click Edit Phonics....

The Word Pronunciation Teacher dialog box opens.
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3. Click Speak to listen to the name.

4. To get a better pronunciation, adjust the pronunciation by selecting pho-
nemes from the American English Phoneme Table list box or typing 
phonemes in the Phoneme text box.

To use the list box:
a. Place the cursor in the Phoneme text box at the location where 

the phoneme should be inserted.
b. Double-click a phoneme in the list box to places the letters for 

that phoneme in the Phoneme text box at the cursor’s location.

5. Repeat steps 3 and 4 as necessary.
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6. When the name sounds as close as possible to the pronunciation you 
want, click Finish to return to the Phonics dialog box.

7. Click OK or Apply.

To add additional pronunciations for a name:

1. Select the name or word that needs an additional pronunciation from the 
Text list box.

For example, if the name is Tomato, pronunciations might include 
tuam'aetoe or tuam'aatoe.

2. Click Add Phonics....

3. Follow steps 3 through 5 in “To change the pronunciation of a name:” on 
page 120.

To delete a pronunciation for a name:

1. Select the pronunciation from the Phonics list box.

2. Click Delete Phonics....

NOTE: When all the pronunciations have been deleted, the 
name in the Text list box is also deleted.

To add a name:

1. Click New Text....

The New Text dialog box opens.

2. Type a new name in the text box.
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3. Click OK.

NOTE: This does not add names to the public directory.
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Chapter 15:
Security Code

You can change your security code using either Amanda Portal Station or 
your telephone. It is a good idea to change your security code immediately 
because your initial security code may be known by several people.

To change your security code:

1. From the Amanda Portal Station window, select the mailbox from the 
mailbox tree whose security code is to be changed.

2. Click the Security Code icon: 
The Security Code dialog box opens.

3. Type the security code you used to log on to Amanda Portal Station in 
the Logon Security Code text box.

4. Type the new code for the selected mailbox in the New Security Code 
text box.

The code must contain at least the number of characters specified by the 
setting of Amanda Portal’s global parameter, security_min_length.

5. Retype the code in the Verify Security Code text box.
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Chapter 16:
Statistics

The Statistics dialog box lets you view statistics about your mailbox, 
including:
• When it was created or changed and by whom
• How often you have logged on
• How many calls you have received
• How often you were notified about calls
• How many messages you have

To view mailbox statistics:

1. From the Amanda Portal Station window, select a mailbox from the 
mailbox tree.

2. Click the Statistics icon: 
The Statistics dialog box displays the data described in the following 
table.
You can refresh the statistics dialog box to be sure that you have the 
most recent data by clicking Refresh.
Unless the Statistics dialog box is locked, you can click Reset to reset 
the statistics (so that most counts start over again). The historical count, 
for example, is never reset.
For more information about locks, see “Understanding Locks” on 
page 116.



128 Using Amanda Portal Station
Mailbox Statistics
Option Description

Created The date and time that this mailbox was created.

Statistics started The date and time that this set of statistics started to accumu-
late. Occasionally statistics are reset for a mailbox; otherwise 
the statistics start at the same time that the mailbox was cre-
ated.

Last modified The most recent date and time at which this mailbox’s set-
tings were changed.

Modified by The mailbox number of the person who last modified this 
mailbox.

Logons Count The number of times the mailbox has been logged on to.

Last The date and time at which the last logon occurred.

Elapsed time The amount of time (in hours, minutes, and seconds) since 
the last logon occurred.

Last heard the 
message of the 
day

the date and time that the user last heard a “message of the 
day.”

Calls Count The number of calls the mailbox has processed.

Last The date and time at which the last call was received.

Elapsed time The amount of time (in hours, minutes, and seconds) since 
the last call was received.

Connected Count The number of calls that were connected to the called party.

Last The date and time at which the last call was connected.

Notifications Count The number of times a notification was sent about calls to 
this mailbox.

Last The date and time at which the last notification was sent.
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Current
(Message Totals)

Urgent new The number of new (that is, unheard) messages that are also 
urgent.

New The total number of unheard messages.

Urgent 
non-new

The number of urgent messages that have already been 
heard.

Marked for 
deletion

The number of messages marked for deletion, but, as yet, not 
purged.

To be purged The number of messages to be automatically purged because 
of their dates.

Total The total number of messages currently in the mailbox.

History
(Message Totals)

Maximum at 
once

The largest number of messages stored in this mailbox at one 
time.

Accumulative 
total

The total number of messages ever stored in this mailbox.

Mailbox Statistics (Continued)
Option Description
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Chapter 17:
Logon Options

You can view and often change the settings for your mailbox’s logon 
options. Amanda Portal Station is normally set up to use these settings to 
control how your mailbox interacts with you, but your settings may be 
ignored or overridden. If you cannot change one or more options, you may 
not have the privilege to do so or this option may have been, at least 
temporarily, locked by you or your administrator. For more information 
about locks, see “Understanding Locks” on page 116.
Some options can be changed using the telephone. For more information, see 
Using Amanda Portal Telephone Features.

To view logon options:

1. From the Amanda Portal Station window, select a mailbox from the 
mailbox tree.

2. Click the Logon Options icon: 
The Logon Options dialog box displays the options described in the fol-
lowing table.
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Logon Options
Option Description

Logon locked When this check box is selected, users cannot log on to mailboxes. 
For example, a mailbox may be used for special processing or you 
might want to lock a user out of the system.

Play connect tone When Amanda is supervising the call transfer, but not identifying the 
called party for the current mailbox, this option determines whether 
Amanda plays a beep for the caller when an answer is detected.
When selected, Amanda plays the beep.
When cleared, there is no beep.
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Play date and time When this check box is selected and you play a message left for you, 
you hear the date and time at which a message was recorded followed 
by the message itself. 

When cleared, the date and time are not played. 

NOTE:  If you are listening to the message over the telephone, you can 
press 74 at any time during the message to hear its date—even if this 
option is cleared.

Abbreviate date 
and time

Controls how Amanda says the date for a message dated today or 
yesterday.
When selected, Amanda says “today” or “yesterday” instead of the 
actual date, for example, “June 27th, 1999.”

When cleared, Amanda says only the actual date, such as “June 27th, 
1999.”

Play from When playing your messages, this option controls whether Amanda 
identifies the Amanda user who sent (or forwarded) each message. 
When selected, Amanda indicates who sent an internal message be-
fore playing the message. Amanda plays the name and extension 
message for the sender (if it exists). Amanda says the mailbox num-
ber (for example, mailbox 1-4-7) when there is no recording. 
When cleared, Amanda only plays the message.

Play new messages 
first

Determines what message is played next when you log on to your 
mailbox to play messages.
When selected, pressing 1 plays the next new message and pressing 
75 plays the messages in order, regardless of whether they have been 
heard.
When cleared, pressing 1 plays the messages in order and pressing 75 
plays the next new message.

Logon Options (Continued)
Option Description
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Auto wrap 
messages

When this check box is selected, as you listen to the last message in 
your mailbox, Amanda automatically returns to the first message as 
the next message.
When cleared, as you listen to your last message, Amanda tells you 
that you have no more messages.

Play skip ___ secs. The number of seconds to rewind or skip forward during message 
playback when a * (rewind) or # (skip forward) is pressed. 
The range is from 1 to 99. The default is 5. 

Language The language of the prompts to be played when the user logs on to 
this mailbox. The language option is never locked; the user can 
change it at any time.

Logon Options (Continued)
Option Description
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Administrative Reports

You can create, view, and print customized reports about Amanda Portal. 
You can also save the report as a text file, which can be imported into other 
applications, such as word processors and spreadsheet applications. There 
you can add other information to the report, reformat it, and so forth. Here 
are some examples of how to use reports.
• To find out who is storing vast numbers of messages, create a report 

that lists mailboxes and their message statistics.
• To monitor use of the Amanda system, create a report that lists mail-

boxes and their numbers of calls, logons, notifications, and transfers.

For reports that you routinely generate, you can create report templates to be 
used whenever you want to regenerate the reports they define.

A report consists of rows and columns of mailbox information and statistics. 
There is one row for each mailbox on your Amanda system and a column for 
each field of information that you decide to include in the report. The rows 
are sorted numerically based on the mailbox. 
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Example Report (When Saved as Text)
                      Administrative Mailbox Reports

                      Saturday, April 24, 1999 11:35:50 PM
Mailbox Extension Name Total Messages New Messages

0 0 Won Park 168 0
2 Sylvia Villa 0 0

111 111 Chris Wang 1987 3
112 112 Nancy Vo 1303 14
113 113 Carl Crockett 313 6
114 114 John Morgan 1745 0
115 115 Rhonda Reid 581 0
116 116 Vinnie Meloni 453 7
117 117 Susan Friend 1882 12
118 118 Kevin Ebrad 573 1
170 0 0

Managing Reports and Report Templates
Managing reports includes:
• Deciding what reports to create and when
• Creating templates for reports that will be generated more than once
• Making decisions about disk space, users, and so forth based on the 

information in the reports

To manage administrative reports:
• From the Amanda Portal Station window, click the 

Administrative Reports icon:

The Administrative Reports window allows you to manage reports.
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This Administrative Reports window has just one drop-down menu. You use 
the file menu to create and save template and to save reports. The other items 
on the menu bar (Query, Set Columns, and Set Mailboxes) are commands. 
You use Set columns and Set Mailboxes to design the report or template. 
You use Query to create the report from the selected template.

The next few sections explain how to create reports and report templates. It 
also explains how to save them as text files.

Creating Reports and Report Templates
Initially you have no report templates, so you must design them and then 
save them. You don’t have to save every template you design. For example, 
the design may be for a report that you will never run again. However, 
usually you will save each template.
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To create a report:

1. From the Administrative Report dialog box, click Set Columns… on the 
menu bar.

The Report Column Designer dialog box opens.

The fields (or properties) you select will appear as columns in the report 
with the field name as the column header.

The possible fields are divided into five tabbed categories: General, 
Privilege, Message, Methods, and Statistics. You can select fields from 
only one or any number of the tabs.

See the Report Fields table at the end of this chapter for a description of 
each field.

The Mailbox field automatically becomes the first column in every 
report. However, it doesn’t appear in the lists.
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2. To select a field to appear as a column in the report:
a. Select one of the tabs above the Fields list box.
b. Select a field from the Fields list box.
c. Click >>Add>> to move that field to the Columns list box.

TIPS: Double-clicking also moves the fields from one list to 
the other. 

If you want the columns in a particular order, you can 
add them in that order or rearrange them later using the 
Move Up and Move Down buttons.

3. Click OK to return to the Administrative Reports dialog box.

4. From the Administrative Report dialog box, click Set Mailboxes… on 
the menu bar.

5. The Report Mailbox Designer dialog box opens. By default, all mail-
boxes are selected.
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6. To limit the report to a subset of these mailboxes:
a. Select a mailbox from the Mailbox Tree.
b. Do one of the following:

• Click >>Add>> to add the selected mailbox.

• Click >>Add All Children>> to add the immediate descendants 
of the selected mailbox.
This does not add the selected mailbox. It adds only the se-
lected mailbox’s children—not its grandchildren, etc.

TIPS: Double-clicking a mailbox in the Report Mailboxes list 
box (or selecting it and clicking <<Remove<<) remove 
that mailbox from the list box.

Click >>Add All>> puts All Mailboxes in the Report 
Mailboxes list box.

7. Repeat step 3 to add additional mailboxes or their children.

8. Click OK to return to the Administrative Reports dialog box.

To process this report:
• Click Query on the menu bar.

The report appears in the Administrative Reports dialog box. For exam-
ple, the following report shows the extensions for three mailboxes.
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To save this report design as a template:

1. Select File⇒ Save Template.... from the menu bar.

The Save Report Template dialog box opens. The word “Report” is the 
prefix for the name of any report.

2. Type a name for the template text box.

3. Click OK.

Creating Reports from Existing Templates
You can create a report from an existing template. First you load the 
template then generate the report. 

To create a report from a template:

1. Select File⇒ Open Template.... from the menu bar.

The Open Report Template dialog box opens.
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2. Select the name of an existing template from the Template drop-down 
list box.

3. Click OK to return to the Administrative Reports dialog box.

4. Click Query on the menu bar.

The report appears in the Administrative Reports dialog box.

TIPS: You can edit a report template by opening it, changing its 
fields or mailboxes. After editing it, you can save it as an 
edited template and/or run a report from it.

You can create new report templates by starting with an ex-
isting template. Edit the existing template and save it with 
a new name.

Saving Reports as Files
Saving a report as a text file allows you to use that file in a word processor, 
spread sheet, database, or file comparison application.

To save a report as a file:

1. Create or open a template.

2. Click Query on the menu bar.

The report appears in the Administrative Reports dialog box.
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3. Adjust any column headers ending in ... to avoid column header trunca-
tion in the text version of the report.

4. Select File⇒ Save Report.... from the menu bar.

The Save As dialog box opens.

5. Select a file name and location.

6. Click OK.

Understanding the Report Fields
The following table describes each report field. It starts with Mailbox, which 
is not on a tab, but which is always the first column of every report. Then it 
provides descriptions of each field in alphabetical order by tab.

Report Fields
Tab Field Name Description

Mailbox Contains the mailbox number. This field is automat-
ically the first column of every report.

General Abbreviate Dates The setting for the logon option, Abbreviate Date 
and Time.
When True, Amanda says “today” or “yesterday” 
instead of the actual date, for example, “June 27th, 
1999.”
When False, Amanda says only the actual date, such 
as “June 27th, 1999.”
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General (cont.) Abbreviate Greeting The setting for the incoming call option, Abbreviate 
“Leave Message” Prompt.
When True, Amanda says, “Please leave a message 
at the tone.” This is the shortened version of the sys-
tem greeting.
When False, Amanda says, “Please leave a message 
for” followed by the name and extension recording. 
This is the usual default version of the system greet-
ing.

Allow Busy Hold The setting for the incoming call option, Allow 
Caller To Hold While Extension Is Busy.
When True, the caller can press * to hold for a busy 
extension. 
When False, a busy signal at your telephone is man-
aged the same way as a Ring No Answer (RNA) 
call. That means that the caller cannot hold for a 
busy extension and can only leave a message once 
RNA or BUSY is the state of the called extension 
(assuming the mailbox accepts messages).

Allow Record Menu The setting for the incoming call option, Play Post-
record Menu.
When True, the caller hears the post-record menu, a 
menu that allows callers to review and/or re-record 
their messages.
When False, the caller does not hear the menu.

Begin Record The setting for the incoming call option, Play “Be-
gin Recording At The Tone” Prompt.
When True, Amanda plays, “Begin recording at the 
tone, finish by pressing # or hanging up” before the 
beep. 
When False, the caller hears only a beep.

Call Screening The setting for the incoming call option, Screen 
Calls.

Report Fields (Continued)
Tab Field Name Description
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General (cont.) Comment The contents of the mailbox’s Comment field (from 
the General Information dialog box).

Current Greeting The description for the current greeting.

Custom Busy Indicates whether this mailbox uses the custom 
busy message.

Do Not Disturb Indicates whether Do Not Disturb is on or off.

Extension The extension connected to this mailbox (as speci-
fied by the Extension field in the General Informa-
tion dialog box).

Greeting Delay The number of milliseconds after the current greet-
ing plays that Amanda waits for the caller to make 
a selection.

Guests Left Remaining number of guest mailboxes that can be 
created from this mailbox.

Identify Called Party Indicates whether Identify Called Party is on or off.

Language The language specified in the General Information 
dialog box.

Mailbox Locked Indicates whether the mailbox is locked.

Max Greeting Length The maximum number of seconds allowed for a 
greeting.

Max Guests The total number of guest mailboxes that can be cre-
ated from this mailbox.

Modified Call Screening Indicates whether Modified Call Screening is on or 
off.

Name The name for the user of this mailbox provided as 
input in the General Information dialog box.

Parent The number of this mailbox’s parent mailbox.

Report Fields (Continued)
Tab Field Name Description
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General (cont.) Play Date/Time Indicates whether the logon option, Play Date And 
Time, is on or off.

Play From Indicates whether the logon option, Play From, is on 
or off.

Play New First Indicates whether the logon option, Play New Mes-
sages First, is on or off.

Play Skip Seconds The number of seconds skipped when rewinding or 
skipping forward through a message over the tele-
phone.

Please Hold Indicates whether the incoming call option, Play 
“Please Hold” Prompt, is on or off.

RNA Rings The number of rings after which the telephone is 
considered unanswered.

Server Location The location of the server from the General Infor-
mation dialog box.

Use Connect Tone Indicates whether the logon option, Play Connect 
Tone, is on or off.

Privilege
See “Privileg-
es” on 
page 110 for 
more details.

Allow Message Privilege Indicates that this mailbox has the Allow Message 
privilege.

Announcement Mailbox 
Privilege

Indicates that this mailbox has the Announce Mes-
sage privilege.

Announcement Privilege Indicates that this mailbox has the Announcement 
privilege.

Auto Schedule Privilege Indicates that this mailbox has the Auto Schedule 
privilege.

Call Screening Privilege Indicates that this mailbox has the Call Screening 
privilege.

Report Fields (Continued)
Tab Field Name Description
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Privilege 
(cont.)

Configuration Privilege Indicates that this mailbox has the Configuration 
privilege.

Create Mailbox Privilege Indicates that this mailbox has the Create Mailbox 
privilege, allowing its owner to create mailboxes—
other than guest mailboxes.

Create Trie Mapping 
Privilege

Indicates that this mailbox has the Create Trie Map-
ping privilege, allowing its owner to create or delete 
a mapping (for example, the public directory is a map-
ping). 

Disconnect Mailbox 
Privilege

Indicates that this mailbox has the Disconnect Mail-
box privilege.

Do Not Disturb Privilege Indicates that this mailbox has the Do Not Disturb 
privilege.

Edit Trie Mapping Privilege Indicates that this mailbox has the Create Mailbox 
privilege, allowing its owner to edit text associated with 
a mapping (for example, because the public directory is a 
mapping, this mailbox’s owner can edit the names and 
pronunciations for the public directory). 

Extension Privilege Indicates that this mailbox has the Extension privi-
lege.

Grammar Privilege Indicates that this mailbox has the Grammar privi-
lege.

Greeting Privilege Indicates that this mailbox has the Greeting privi-
lege.

Message Copy To Privilege Indicates that this mailbox has the Message Copy 
To privilege.

Message Relocation Privi-
lege

Indicates that this mailbox has the Message Reloca-
tion privilege.

Method Database Privilege Indicates that this mailbox has the Method Database 
privilege.

Report Fields (Continued)
Tab Field Name Description
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Privilege 
(cont.)

Method Edit Privilege Indicates that this mailbox has the Method Edit 
privilege.

Monitor Privilege Indicates that this mailbox has the Monitor privi-
lege.

Notify Record Privilege Indicates that this mailbox has the Notify Record 
privilege.

Notify Template Privilege Indicates that this mailbox has the Notify Template 
privilege.

Reset Port Privilege Indicates that this mailbox has the Reset Port privi-
lege.

Reset Statistics Privilege Indicates that this mailbox has the Reset Statistics 
privilege.

Route Privilege Indicates that this mailbox has the Route privilege.

Shutdown Privilege Indicates that this mailbox has the Shutdown privi-
lege.

Message Allow Messages Indicates whether the mailbox takes messages.

Deleted Messages Indicates the number of messages marked for dele-
tion.

Folder New The description of the folder that contains new mes-
sages.

Folder Urgent The description of the folder that contains urgent 
messages.

Max Message Length The maximum number of seconds allowed for a 
message.

Max Messages At Once The largest number of messages stored by this mail-
box at one time.

Report Fields (Continued)
Tab Field Name Description



Chapter 18: Administrative Reports 149
Message 
(cont.)

Messages To Be Purged The number of messages to be purged (based on 
age).

Purge Deleted Messages Indicates whether deleted messages are to be 
purged.

Purge Messages Indicates whether messages are purged based on 
age.

Total Current Messages The total number of messages currently in the mail-
box.

Total Received Messages The total number of messages received since the 
statistics were last reset.

Unread Messages The number of unreviewed messages in the mail-
box.

Urgent Messages The number of urgent messages in the mailbox.

Urgent Read Messages The number of urgent messages in the mailbox that 
have already been reviewed.

Methods
See “Chapter 
5: Chain Infor-
mation” for 
more details.

Busy Method The contents of the Busy Method text box.

Caller Method The contents of the Caller Method text box.

Done Method The contents of the Done Method text box.

Menu 0–9 Method The contents of the Menu 0–9 Method text box.

RNA Method The contents of the RNA Method text box.

Transfer Method The contents of the Transfer Method text box. 
Transfer Method is a incoming call option.

User Method The contents of the User Method text box.

Statistics Call Count The setting for the Call Count statistic.

Called Seconds The setting for the Called Seconds statistic.

Report Fields (Continued)
Tab Field Name Description
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Statistics 
(cont.)

Connect Count The setting for the Connect Count statistic.

Initial Time The setting for the Initial Time statistic.

Last Call Time The setting for the Last Call Time statistic.

Last Changer The setting for the Last Changer statistic, the mail-
box number of the last user to modify this mailbox’s 
settings.

Last Connect Time The setting for the Last Connect Time statistic.

Last Notify Time The setting for the Last Notify Time statistic.

Last User Logon Time The setting for the Last User Logon Time statistic.

Message Of The Day The setting for the Message Of The Day statistic, in-
dicating whether the owner of this mailbox has 
heard the message of the day.

Notify Count The setting for the Notify Count statistic.

Save Time The setting for the Save Time statistic.

Statistic Time The setting for the Statistic Time statistic.

User Logon Count The setting for the User Logon Count statistic.

User Logon Seconds The setting for the User Logon Seconds statistic.

Report Fields (Continued)
Tab Field Name Description
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Administrative Monitor

Amanda’s Administrative Monitor lets you view the real time status of the 
Amanda system server from a workstation on your Wide Area Network 
(WAN).

To access Administrative Monitor:
• From the Amanda Portal Station window, click the 

Administrative Monitor icon:

The Monitor Logon dialog box displays general information about the 
Amanda system.

If the entire dialog box is locked (see the Locked button at the bottom of 
the dialog box), nothing appears in this dialog box on any tab. 

If the dialog box is locked, you might not have permission to unlock it. 
See your supervisor or Amanda administrator for details. For more 
information about locks, see “Understanding Locks” on page 116.

If the entire dialog box is unlocked, individual tabs may be locked, pre-
venting you from seeing information and performing operations such as 
resetting ports or disconnecting users.
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Monitoring Ports
You can check to see what ports are doing what activities. You can also reset 
those ports. Reset ports with caution as this immediately terminates any 
activity on that port and sets the port to on-hook.

To monitor ports:
• From the Monitor dialog box, click the Ports tab.

The Ports dialog box lists the ports currently connected to the Amanda 
server. 

The following table explains the columns found in the dialog box.
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Resetting Ports
You can reset individual ports on the Amanda system without shutting down 
the system. Resetting a port forces a hangup and changes the port’s state to 
on-hook.

CAUTION: Anyone using the port being reset will be disconnected 
without warning.

Ports
Column Description

Port The number of each active port.

State The current state of that port. 
on-hook
off-hook
t1-red-on
t1-red-off
t1-blue-on
t1-blue-off
t1-yellow-on
t1-yellow-off
t1-other-on
t1-other-off

Mailbox The current mailbox being accessed on that port, or the last mailbox ac-
cessed if the port is now IDLE.

Calls The total number of calls answered on that port.

Status Detailed information on the current activity of this port.

Last Call 
Taken

The last time a call was taken.
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To reset a port:

1. From the Monitor dialog box, click the Ports tab.

2. Select a port from the Ports list box then click Reset Port.

3. Click OK.

Monitoring Users
You can check to see what users are doing what activities. You can also 
disconnect users.

To monitor users:
• From the Monitor dialog box, click the Users tab.

The Users dialog box lists the mailboxes currently connected to the 
server as clients.

The following table explains the columns found in the dialog box.

Users
Column Description

Session ID The systemwide session ID.

Category Explains what the user is doing or what is being done on his behalf.

Auto 
Scheduler

A schedule is being executed on behalf of a user.

monitor A monitoring activity is being executed.

network A user is connected through telnet, CallQ, or Amanda 
Portal Station.
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Disconnecting Users
Disconnect users with caution. It is not going to please them.

To disconnect a user who is accessing a mailbox:

1. From the Monitor dialog box, click the Users tab.

2. Select a user from the Users list box then click Disconnect Mailbox.

3. Click OK.

Category 
(cont.)

notify A notification record is being executed.

phone A user is connected via a telephone.

POP3 A user is connected through a POP3 network.

SMTP A user is connected through an SMTP network.

sound card A user is connected through the sound card. For exam-
ple, the user is recording a greeting.

spawn A job is being executed.

startup The startup job is being executed (as the Amanda server 
starts).

template A notification record is being executed.

www A user is connected through the world-wide web/
Internet.

Mailbox The user’s mailbox number.

Host The user’s host name or IP address.

Users (Continued)
Column Description
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Tracing Port Activity
The path to Amanda’s trace file is usually:
C:\amanda\computerName_trace.txt

where computerName is the name of your computer.

This file is located wherever you have installed Amanda. It is created each 
time Amanda starts running. It may wrap around depending on the 
trace_wrap configuration setting.

The trace file allows the administrator to:
• Check on the results of configuration changes
• Have trace information available if he needs to call The Amanda 

Company customer support for assistance

From Administrative Monitor, you can create trace files on your local 
workstation (or network). From Amanda, you can create trace files on the 
server. You can copy trace files from the server to your workstation (or 
network).

To trace Amanda server activity:
• From the Monitor dialog box, click the Trace tab.

The Trace dialog box lists the commands executed by Amanda server at 
that time.

The following table explains the columns found in the dialog box.

Trace
Column Description

Time The time at which the command was executed.

Header The category of the trace information, for example, port, network, etc.

Body The trace details.
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To save the displayed data as a trace file:

1. From the Monitor dialog box, click the Trace tab.

2. Click File Trace....

The Windows standard Save As dialog box opens.

3. Select a file name and location then click OK.

Checking General Information
General information includes:
• Version number
• System usage information
• Number of mailboxes
• Amount of hard disk space available
• When the system was last started

To monitor general activity:
• From the Monitor dialog box, click the General tab.

Monitoring Resources
You can use resource information to find bottlenecks in the Amanda system 
and determine if another voice board is needed.

To monitor resources:
• From the Monitor dialog box, click the Resources tab.

The following table explains the columns found in the dialog box.
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Resources
Column Description

Type The type of resource being used.

fax Fax processing device.

ls Loopstart device: line device that sets hook on/off.

serial Serial port, usually for SMDI.

sndcard Sound card device.

T1 T1 device; time slot.

vp Voice processing device (DSP) for playing, recording, 
and dialing PCPM.

vpls Voice processing device attached to a loopstart device.

vptone Independent, crippled voice processing device.

Total The number of resources of the specified type currently allocated to the 
system.

Available The number of resources of the specified type currently available for use.

Max Ever 
Used

The maximum number of this type of resource ever used at one time since 
the system has been up.

Times Denied The number of times that this type of resource was needed but was not 
available.

Waiting The number of people waiting to use this type of resource at that moment.

Max Ever 
Waiting

The maximum number of people waiting to use this type of resource at one 
time since the system has been up.
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Tcl Command

You can evaluate tcl commands using the Tcl Command dialog box. This 
gives you the opportunity to test the command before you add it to a method, 
etc.

To test tcl commands:

1. From the Amanda Portal Station window, click the 
Tcl Command icon:

The Tcl Command dialog box opens.

2. Type the command in the Tcl Command text box.

3. Select the Local User, Server User, or Application option button.
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There are three tcl interpreters available to you: one on the server and 
two on the client workstation. The server interpreter has access to every-
thing. The local user interpreter has access to information about the cur-
rent mailbox. The application interpreter has access to mailbox numbers.

4. Click Evaluate.

The Tcl Result window opens.

The result from the command appears in the top pane.

Any asynchronous data requested by the command appears in the bot-
tom pane. The above figure shows asynchronous information sent by the 
puts command.

TIP: If you type the command incorrectly, you can edit it or click 
Clear to start over.
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